Legal Notices
This guide is copyrighted ©2011 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.

Guide Part Number 9329-65112-00 REV A 10 /11

Documentation Feedback
At Avid, we are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.
Contents

Chapter 1. Introduction to Pro Tools Menus ................................................................. 1

Chapter 2. Pro Tools Menu (Mac Only) ................................................................. 3
   About Pro Tools or About Pro Tools HD ......................................................... 3
   Preferences ........................................................................................................ 3
   Mac Application Management Commands .................................................... 3
   Quit Pro Tools .................................................................................................... 3

Chapter 3. File Menu ............................................................................................... 5
   New Session ....................................................................................................... 5
   Open Session ...................................................................................................... 5
   Open Recent ...................................................................................................... 5
   Close Session ..................................................................................................... 5
   Save ................................................................................................................... 5
   Save As .............................................................................................................. 5
   Save Copy In. ..................................................................................................... 6
   Save As Template .............................................................................................. 7
   Revert to Saved. ............................................................................................... 8
   Send via DigiDelivery. .................................................................................... 8
   Send to Sibelius. .............................................................................................. 8
   Bounce to Commands ..................................................................................... 8
   Import ............................................................................................................... 10
   Export .............................................................................................................. 12
   Get Info. ............................................................................................................ 13
   Score Setup ...................................................................................................... 13
   Print Score ....................................................................................................... 14
   Exit .................................................................................................................... 14
Chapter 4. Edit Menu

Undo .......................................................... 15
Redo .......................................................... 15
Restore Last Selection ................................. 15
Cut ........................................................... 15
Copy ........................................................ 15
Paste ........................................................ 15
Clear ......................................................... 15
Cut Special ................................................. 16
Copy Special .............................................. 16
Paste Special .............................................. 16
Clear Special .............................................. 16
Select All .................................................. 17
Selection ................................................... 17
Duplicate .................................................. 17
Repeat ...................................................... 17
Shift ......................................................... 17
Insert Silence ........................................... 17
Snap To ..................................................... 17
Trim Clip .................................................. 18
Separate Clip ............................................. 18
Heal Separation ......................................... 18
Consolidate ............................................... 18
Mute/Unmute Clip ....................................... 19
Copy Selection To ....................................... 19
Strip Silence ............................................. 19
TCE Edit to Timeline Selection ..................... 19
Automation ............................................... 20
Fades ....................................................... 22

Chapter 5. View Menu

Mix Window ............................................... 23
Narrow Mix ............................................... 23
Edit Window Views ..................................... 23
Rulers ....................................................... 24
Other Displays .......................................... 24
Clip ........................................................ 25
Waveforms ................................................................. 26
Automation .............................................................. 26
Sends A–E ................................................................. 27
Sends F–J ................................................................. 27
Track Number ........................................................... 27
Transport ................................................................. 27
Main Counter ............................................................ 27

Chapter 6. Track Menu ..................................................... 29
New ................................................................. 29
Group ................................................................. 29
Duplicate ............................................................... 30
Split into Mono .......................................................... 30
Make Inactive or Make Active .......................................... 30
Delete ................................................................. 30
Write MIDI Real-Time Properties ......................................... 30
Set Record Tracks to Input Only or Set Record Tracks to Auto Input ............................................................... 31
Auto Input Monitoring or Input Only Monitoring ......................... 31
Scroll To Track .......................................................... 31
Clear All Clip Indicators ................................................ 32
Coalesce VCA Master Automation ......................................... 32
Coalesce Trim Automation ................................................ 32
Clear Trim Automation ................................................... 32
Create Click Track ......................................................... 32

Chapter 7. Clip Menu ......................................................... 33
Edit Lock/Unlock ........................................................... 33
Time Lock/Unlock .......................................................... 33
Send to Back ............................................................... 33
Bring To Front ............................................................. 33
Rating ................................................................. 33
Group ................................................................. 34
Ungroup ................................................................. 34
Ungroup All ............................................................... 34
Regroup ................................................................. 34
Loop ................................................................. 34
Unloop ................................................................. 34
Pro Tools Menus Guide

Chapter 8. Event Menu
Time Operations ................................................. 37
Tempo Operations ............................................. 39
Event Operations .............................................. 40
MIDI Track Offsets ............................................ 44
MIDI Real-Time Properties ................................. 44
Remove Duplicate Notes ................................. 44
Add Key Change ............................................. 44
Beat Detective ................................................. 45
Identify Beat ................................................. 45
Renumber Bars ............................................. 45
All MIDI Notes Off ....................................... 45

Chapter 9. AudioSuite Menu ............................... 47
Avid Marketplace ........................................... 47

Chapter 10. Options Menu ................................. 49
Destructive Record ........................................ 49
Loop Record ................................................ 49
QuickPunch ................................................ 49
TrackPunch ................................................ 49
DestructivePunch ...................................... 49
Prepare DPE (DestructivePunch-Enabled) Tracks .... 50
Transport Online ......................................... 50
Video Track Online ....................................... 50
Video Out FireWire ..................................... 50
Scrub in Video Window ................................. 50
Pre/Post-Roll ............................................. 50
Loop Playback .......................................................... 51
Dynamic Transport .................................................. 51
Edit Window Scrolling ............................................. 51
Link Timeline and Edit Selection .............................. 52
Link Track and Edit Selection ................................ 52
Mirror MIDI Editing .................................................... 52
Automation Follows Edit ........................................... 52
Click ........................................................................ 52
MIDI Thru ............................................................... 52
Mute Frees Assigned Voice ...................................... 52
Auto-Spot Clips ......................................................... 53
Pre-Fader Metering .............................................. 53
Solo Mode ............................................................... 53
Edit/Tool Mode Keyboard Lock ............................... 53
Calibration Mode ...................................................... 54
Delay Compensation .............................................. 54
Activate HEAT ......................................................... 54
Low Latency Monitoring ............................................. 54

Chapter 11. Setup Menu .............................................. 55
Hardware ............................................................... 55
Playback Engine .................................................. 55
Disk Allocation ....................................................... 56
Peripherals ............................................................ 56
I/O ................................................................. 58
Machine Track Arming Profiles ............................ 58
Video Sync Offset ............................................... 58
Session ............................................................... 59
Current Feet+Frames Position ............................ 59
Current Timecode Position ................................ 59
External Timecode Offset ................................ 60
MIDI ............................................................... 60
Connect to SoundCloud ...................................... 62
Click/Countoff ..................................................... 62
Preferences .......................................................... 62
## Chapter 12. Window Menu

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurations</td>
<td>63</td>
</tr>
<tr>
<td>Arrange</td>
<td>63</td>
</tr>
<tr>
<td>Hiding All Floating Windows</td>
<td>63</td>
</tr>
<tr>
<td>Close Window</td>
<td>64</td>
</tr>
<tr>
<td>Mix</td>
<td>64</td>
</tr>
<tr>
<td>Edit</td>
<td>64</td>
</tr>
<tr>
<td>MIDI Editor</td>
<td>64</td>
</tr>
<tr>
<td>Score Editor</td>
<td>64</td>
</tr>
<tr>
<td>MIDI Event List</td>
<td>64</td>
</tr>
<tr>
<td>MIDI Editors</td>
<td>64</td>
</tr>
<tr>
<td>Task Manager</td>
<td>64</td>
</tr>
<tr>
<td>Workspace</td>
<td>64</td>
</tr>
<tr>
<td>Project</td>
<td>65</td>
</tr>
<tr>
<td>Browsers</td>
<td>65</td>
</tr>
<tr>
<td>Transport</td>
<td>65</td>
</tr>
<tr>
<td>Big Counter</td>
<td>65</td>
</tr>
<tr>
<td>Automation</td>
<td>65</td>
</tr>
<tr>
<td>Memory Locations</td>
<td>66</td>
</tr>
<tr>
<td>Machine Track Arming</td>
<td>66</td>
</tr>
<tr>
<td>Video Universe</td>
<td>66</td>
</tr>
<tr>
<td>Video</td>
<td>66</td>
</tr>
<tr>
<td>Color Palette</td>
<td>67</td>
</tr>
<tr>
<td>Undo History</td>
<td>67</td>
</tr>
<tr>
<td>Disk Space</td>
<td>67</td>
</tr>
<tr>
<td>System Usage</td>
<td>67</td>
</tr>
<tr>
<td>Eleven Rack</td>
<td>69</td>
</tr>
</tbody>
</table>

## Chapter 13. Marketplace Menu

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Account</td>
<td>71</td>
</tr>
<tr>
<td>Plug-Ins</td>
<td>71</td>
</tr>
<tr>
<td>Avid Support</td>
<td>71</td>
</tr>
<tr>
<td>Upgrades</td>
<td>71</td>
</tr>
</tbody>
</table>
Chapter 14. Help Menu .......................................................... 73
Pro Tools Help ................................................................. 73
Pro Tools Knowledge Base ................................................. 73
Avid Audio Forums .......................................................... 73
Pro Tools Guides .............................................................. 73
Purchase Avid Support and Training ................................. 73
Check For Updates ............................................................ 74
About Pro Tools ............................................................... 74

Chapter 15. Clip List ............................................................. 75
Find ................................................................................. 75
Clear Find ....................................................................... 75
Select Parent in Project Browser ...................................... 75
Show Options .................................................................. 76
Select Options .................................................................. 76
Sort By Options .................................................................. 77
Clear ................................................................................. 77
Rename ............................................................................. 77
Auto Rename .................................................................... 77
Time Stamp ....................................................................... 78
Replace Clip ...................................................................... 78
Compact ........................................................................... 78
Export Clip Definitions ...................................................... 78
Export Clips as Files ......................................................... 79
Export Clip Groups ........................................................... 79
Recalculate Waveform Overviews ..................................... 79
Timeline Drop Order ........................................................ 79

Index .................................................................................. 81
Chapter 1: Introduction to Pro Tools Menus

Pro Tools® menus provide commands and options for configuring and working with Pro Tools, sessions, and session material.

For complete information about Pro Tools software, see the Pro Tools Reference Guide.
Chapter 2: Pro Tools Menu (Mac Only)

The Pro Tools Menu commands include links to Pro Tools Preferences, access to Mac OS X application management, and the Quit command.

### About Pro Tools or About Pro Tools HD

The About Pro Tools or About Pro Tools HD command launches the Pro Tools banner, which includes the version number of your Pro Tools software.

### Preferences

Pro Tools Preferences are available from both the Pro Tools Menu and the Setup menu.

### Mac Application Management Commands

(Services, Hide Pro Tools, Hide Others, Show All)

The Pro Tools menu provides access to the following Mac OS X application management commands: Services, Hide Pro Tools, Hide Others, and Show All. For more information about these and other Mac OS X features, refer to the documentation for your Mac computer.

### Quit Pro Tools

The Quit Pro Tools command ends your Pro Tools session and closes the Pro Tools application.
Chapter 3: File Menu

File menu commands are used to create and maintain Pro Tools sessions.

New Session

The New Session command creates a new Pro Tools session. You can choose to either create a session from a template (Create Session From Template) or create a blank session (Create Blank Session).

If you choose to create a new session from a template, the available templates appear in the Session Template List.

Before the session is created, you must also name the session and choose its Audio File Type, Sample Rate, Bit Depth, and I/O Settings in the New Session dialog.

Open Session

The Open command opens a session previously created with Pro Tools. Only one session can be open at a time.

Open Recent

The Open Recent command lets you open any of the 10 most recently opened Pro Tools session. It also provides a Clear command to remove all sessions from the list.

Close Session

The Close command closes the current session without quitting Pro Tools. Pro Tools prompts you to save changes before closing the session.

Save

The Save command saves changes made since the last time the session was saved. You cannot undo the Save command.

Save As

The Save As command lets you save a copy of the current session under a different name, or in a different location. Because the Save As command closes the current session and allows you to keep working on the renamed copy, it is useful for saving successive stages of the session.
Save Copy In

The Save Copy In command lets you save a copy of the currently selected session under a different name or in a different location. Session media can be included in the copy that you save, with options to save the media at a different bit depth, sample rate, fader gain level, or file format type. Sessions can be saved in a variety of session formats for compatibility with older systems. This command is useful for archiving sessions.

Unlike the Save As command, Save Copy In does not close the original session, so subsequent edits are made to the original session. The saved copy becomes a backup copy, and gives you the option of returning to the earlier version.

When you Save Copy In with a lower bit rate, Pro Tools Dither with Noise Shaping will be applied. The Dither setting used for any conversion is the Digidesign® Dither plug-in with Noise Shaping enabled.

The Items To Copy section of this dialog provides several options for copying a session along with its associated files.

Audio Files

When this option is selected, all audio files are copied to the new location.

This setting is automatically selected if you select a Session Format lower than 10.0.

Convert To Specified Format

When the Convert To Specified Format option is selected, all copied audio files are converted to the specified audio file format settings in the Session Parameters section. When this option is not selected, any copied audio files retain their original audio file format settings (including sample rate and bit depth), and are exactly copied, bit-by-bit.

Note that copying formats bit-by-bit is much faster than converting files.

This option is automatically selected if you do any of the following:

- Save to a session format lower than 10.0.
- Enable Enforce Mac/PC Compatibility.

Don't Copy Elastic Audio Rendered Files

When this option is selected, Elastic Audio Rendered files are not copied to the new session's Rendered Files folder.

When opening the new session, Pro Tools opens the session with all available media and any missing Rendered files are regenerated automatically.
Main Playlist Only

When this option is selected, only the main playlists are included with the session copy. Any alternate playlists are not included with the session copy.

When this option is not selected, all playlists are included with the session copy.

Selected Tracks Only

When this option is selected, only the selected tracks in the source session are saved with the session copy. This option is automatically enabled when choosing File > Export > Selected Tracks As New Session.

When this option is not selected, all tracks in the source session are saved with the session copy. This option is automatically disabled when choosing File > Save Session Copy.

Session Plug-In Settings Folder

When this option is selected, the session’s Plug-In Settings folder is copied to the new location. The references to these plug-in settings in the session are redirected to the copied settings files.

Root Plug-In Settings Folder

When this option is selected, the contents of the root-level Plug-In Settings Folder are copied into a folder named Place in Root Settings Folder, indicating that these files will need to be moved to the root level plug-in settings folder on the destination system before you can use them. The references to these settings files in the session are not redirected to point to the copied files.

Movie/Video Files

When this option is selected, session video files (Avid or QuickTime) are copied to the new location, and session references are updated to point to the copied video files.

Preserve Folder Hierarchy

When this option is selected, the relative arrangement of session audio files located across different drives or folders is maintained. The main folder for the session copy will include subfolders for each drive or folder in the original session and the destination subfolders will use the same names as the source drives and folders.

When this option is not selected, the Save Copy In command copies all files of the same type, regardless of their location, into a single destination folder.

Save As Template

The Save As Template command allows you to save the current session as a Pro Tools Session Template (a .ptt file).

Save Session Template dialog

The Save Session Template provides several options for saving the session as a template.
Install Template in System When selected, this option saves the session as a template in the folder referenced by the Pro Tools Quick Start dialog (the Session Templates folder). From the Category pop-up menu, you can select a category (or create a new one), or you can open the Session Templates folder using the Reveal Session Templates Folder command. You can also name the template.

Select Location for Template When selected, the Save As dialog opens, allowing you to save the session template in any directory location.

Include Media When selected, audio and video files are saved along with the template.

Revert to Saved

The Revert to Saved command restores the most recently saved version of a session, discarding all changes made since the last time you saved. Reverting to the last saved version of a session is like closing the session without saving changes and reopening it.

Send to Sibelius

The Send To Sibelius command exports all MIDI and Instrument tracks to Sibelius® or G7 notation software as a MIDI file. You can then further edit the notation in Sibelius (or G7) and print the score of your session.

Bounce to Commands

The Bounce to commands let you mix tracks together into one file.

Bounce to Disk

The Bounce to Disk command allows you to mix together the outputs of all currently audible tracks routed to a common output path to create a new audio file. You can use the Bounce to Disk command to create a submix or to create a final mix in any of several audio file formats.

For more information about DigiDelivery, visit the Aspera website (http://www.asperasoft.com).
Main Bounce Options

The following Bounce options are available when bouncing to the same or different file type, format, resolution, or sample rate.

Bounce Source Selects the audio output path to bounce. Only audio routed to the selected path will be included in the bounce.

File Type Selects the audio file type. Choices on all systems are WAV (BWF), AIFF, MP3, QuickTime, and MXF. Windows systems also include Windows Media (Windows). Mac systems also include SD II.

Certain file types are restricted in regards to format, resolution, and sample rate.

Format Selects the channel format (number of channels). Choices are mono (summed), multiple mono, or interleaved.

Bit Depth Selects the bit depth. Choices are 24, 16, or 8 bit resolution.

Sample Rate Selects the sample rate (from 8 kHz to 192 kHz).

Whenever a Bounce to Disk is configured to a different file type, file format, resolution, or sample rate, additional options become available to convert during or after the bounce. See “Additional Bounce Options” on page 10 for more information.

Enforce Avid Compatibility Creates frame-accurate edits, wraps the files as OMFI (unless File Type is MXF), and limits the sample rate options to 44.1 kHz or 48 kHz. Dithering without noise shaping will be applied to files being exported from 24-bit to 16-bit.

Import After Bounce Automatically imports the audio after it is bounced and adds it to the Clip List so that it can be used in the session. The bounced audio can be imported into a new track (and the Clip List), or the Clip List only.

The Import After Bounce option is only available if the target file type and sample rate for the bounce are the same as the file type and sample rate of the current session, and the target resolution (bit rate) is the same or lower than the resolution of the session. In addition, tracks bounced to a Stereo Interleaved file cannot be imported after a bounce.

Add To iTunes Library Lets you bounce your mix to your iTunes library. When this option is selected, the bounced file is copied to your local iTunes library. If the Add to iTunes Library option is enabled when bouncing to disk, the resultant audio file is automatically imported into iTunes the next time you launch the iTunes application. If iTunes is not installed on your computer, this option does not do anything.
**Share With SoundCloud** Lets you share your mix with SoundCloud, a social audio sharing site that lets you feature your tracks or playlists on social networks (such as Twitter, Facebook, and Google+). When this option is selected, the bounced file is automatically uploaded to your SoundCloud account. If you do not have an account, you can create one for free.

**Additional Bounce Options**

The following Bounce options are only available when bouncing to a different file type, format, resolution, or sample rate.

**Conversion Quality** Selects the quality, with option ranging from Low to Tweak Head, when bouncing to a new sample rate.

**Use Squeezer** Optimizes the dynamics of the bounced audio before conversion to 8-bit resolution.

**Convert During Bounce** Automatically performs file type, sample rate, and bit resolution conversion as the file is being bounced.

**Convert After Bounce** Automatically performs file type, sample rate, and bit resolution conversion after the file has been bounced.

⚠️ The Convert After Bounce option takes slightly longer than the Convert During Bounce option, but may better preserve the timing and results of automation data in some cases.

**Bounce to QuickTime Movie**

This command lets you bounce the main video track (QuickTime or Avid® video) and a mono or stereo mixdown of your session to a new QuickTime movie. Pro Tools will convert the audio tracks to the selected sample rate and bit resolution, then create a new flattened movie with the bounced audio. As a QuickTime file, the new movie is supported by all software applications that support QuickTime video. For detailed information about bouncing video tracks to a QuickTime or Avid video, refer to the Pro Tools Reference Guide.

---

**Import**

Pro Tools provides several menu commands to import files and clips into an open session.

**Import Session Data**

This command lets you import selected session data from an existing session into the current session. Use this option to import entire tracks from one session into another. Options are provided for text encoding, timecode mapping, track offset options, sample rate conversion, and copying, converting, and referencing audio and video source files. The Import Session Data command also lets you import the Tempo Meter Map, and any Key Signature Maps, Markers/Memory Locations, and Window Configurations.
Chapter 3: File Menu

Pro Tools lets you select specific session data (such as automation and routing) to import. You can also import main playlist options—either replacing existing options or overlaying elements onto existing tracks.

**Import MIDI**

The Import MIDI command imports all tracks from a Standard MIDI file into Pro Tools. MIDI files can be imported into a new track (and the Clip List) or the Clip List only.

Options are provided for importing the Session Start or Song Start Marker (if the marker is not located at the session start), importing tempo map data contained in the sequence, and removing existing Instrument or MIDI tracks.

**Import Video**

This command lets you import Avid Video (Pro Tools|HD systems with an Avid video peripheral only) or QuickTime into the main video track (and the Clip List), a new track (and the Clip List), or the Clip List only.

The Import Video command can also be used to extract (import) audio from a Quicktime Movie.

**Import Clip Groups**

This command lets you import clip groups into the current session. Clip groups can be imported into a new track (and the Clip List) or the Clip List only.

**Import Sequence from Avid Interplay**

(Pro Tools HD with Avid Interplay Only)

This command opens the Interplay Access browser for accessing files on Interplay servers. For more information, see the Pro Tools Avid Interplay Guide.

---

Import Session Data dialog (Pro Tools session data shown)

If you are importing AAF or OMF sequences, different options are provided in the Import Session Data dialog.

*For information on importing AAF and OMF sequences, see “Importing and Exporting Session Data” in the Pro Tools Reference Guide.*

**Import Audio**

This command lets you import audio files into the current session. Audio files can be imported into a new track (and the Clip List) or the Clip List only.
Import VENUE Channel Names as Track Names

This command lets you import VENUE channel names as track names into the current session. VENUE system channel names, channel ordering, and all I/O routing is transferred to the Pro Tools session. This information corresponds to channel names and bussing configurations found in the VENUE system Patchbay.

Output routing mirrors input routing in Pro Tools one-for-one, so that when playing back Pro Tools tracks through the VENUE system, the Pro Tools tracks appear in the same channels as the corresponding Stage inputs.

Export

Pro Tools provides several menu commands to export session tracks or data as files.

Export Selected Tracks as AAF/OMF

The Export Selected Tracks as AAF/OMF command exports selected tracks in AAF and OMFI format. Advanced Authoring Format (AAF) and Open Media Framework Interchange (OMFI) are industry standard file formats that facilitate the transfer of digital media between applications (such as Pro Tools and Avid Video editing software).

Export Selected Tracks to Sequence

This command lets you export tracks back into a sequence in Interplay. For more information, see the Pro Tools Avid Interplay Guide.

Export MIDI

This command lets you export your Pro Tools session or individual MIDI or Instruments tracks as a standard MIDI file. You can export the file as a Type 1 (multitrack) or Type 0 (merged) Standard MIDI file. The exported MIDI file includes meter and tempo information, and any key signatures in your Pro Tools session.

Muted MIDI tracks will not be exported.

This can be useful for storing libraries of your favorite MIDI sequences or SysEx data (such as bulk or individual patch dumps for your external MIDI devices), or for importing MIDI into notation applications other than Sibelius or G7.

Export Sibelius

This command exports the score from your session as a Sibelius (.sib) file. You can then open your score in Sibelius as transcribed by Pro Tools, edit the notation in Sibelius as desired, and print the score and parts from Sibelius.

Export Session Info as Text

This command exports the current session as a tab-delimited text file that can contain clip and file names, extended timestamp information, and information about crossfades.
You can export to any of several different text file formats (including Microsoft Word and Excel). (Mac only)
– or –
You can export to text (.txt) file format. (Windows only)

Get Info
This command lets you enter and save information about the session.

Left-column text fields are topic fields. Text entered there is saved with your Pro Tools Preferences and will appear in all sessions, allowing you to preset the field to topics that you commonly use.

Right-column text fields are information fields and are session specific and will be saved with the session.

Score Setup
Selecting Score Setup opens the Score Setup window. This window lets you set up the page layout and staff spacing of your score, viewable in the Score Editor window. You can also enter the Title and Composer for the score and select what elements of the score to display. Changes to the Score Setup update dynamically in the Score Editor.

Pro Tools provides several options in the Score Setup window.
Information

Title Enter the Title for the score. This appears at the top of the first page.

Composer Enter the Composer for the score. This appears in the upper right-hand corner of the first page.

Display

The Display options determine which score elements you want displayed in the score. Deselect the elements you do not want displayed in the score.

Title and Composer Select to display the Title and Composer on the score.

Page Numbers Select to display Page Numbers at the bottom of each page.

Bar Numbers Select to display Bar Numbers at the beginning of each system above the top staff.

Track Names Select to display Track Names for each staff at the beginning of the score.

Chord Symbols Select to display chord symbols in the score.

Chord Diagrams Select to display Chord Diagrams to display guitar tablature in the score.

Spacing

Between Staves Enter the desired amount of spacing (in staff spaces) between staves.

Between Systems Enter the desired amount of spacing (in staff spaces) between systems.

Below Title and Composer Enter the desired amount of spacing (in staff spaces) between the Title and Composer and the first staff of the score.

Below Chord Symbols and Diagrams Enter the desired amount of spacing (in Inches or Millimeters) between Chord Symbols and Diagrams, and the top stave of each system.

Layout

Page Size Select the page size (Letter, Legal, Tabloid, or A4).

Portrait Select to set the page orientation to Portrait.

Landscape Select to set the page orientation to Landscape.

Staff Size Enter the Staff Size (in Inches or Millimeters).

Page Margins Enter the size (in Inches or Millimeters) for the top, bottom, left, and right page margins.

Inches Select to enter Stave Size, Page, Margins, and Spacing in inches.

Millimeters Select to enter Stave Size, Page, Margins, and Spacing in millimeters.

Print Score

The Print Score command lets you print the score from your Pro Tools session. Pro Tools provides WYSIWYG (“what you see is what you get”) printing. Configure the Score Setup as desired and show or hide any MIDI and Instrument tracks as desired. Only those tracks that are shown in the score will be printed.

Exit

(Windows Only)

The Exit command ends your Pro Tools session and closes the Pro Tools application.
Chapter 4: Edit Menu

Edit menu commands are used to edit and manipulate the current selection and affect data in the timeline or the clipboard.

**Undo**

The Undo command lets you sequentially undo up to 32 of your previous actions. Certain commands and actions (such as saving) are not undoable. The last command in the undo queue will appear in the menu (for example, “Undo Paste”).

If no actions are available to undo, the menu displays a grayed out Can't Undo.

**Redo**

After undoing a command or action, you can redo it by choosing the Redo command. This is a good way to compare before and after states of edits.

If no actions are available to redo, the menu displays a grayed out Can't Redo.

**Restore Last Selection**

If you lose the current Edit (or Timeline) selection and want to restore it, use the Restore Last Selection command.

If no actions are available to restore, the menu displays a grayed out Restore Last Selection.

**Cut**

This command cuts a selection out of its current location and stores it in memory so that you can paste it elsewhere.

**Copy**

This command copies a selection (leaving the original intact) and stores it in memory so that you can paste it elsewhere.

**Paste**

This command inserts cut or copied data into a location specified with an Edit tool (such as the Selector tool).

**Clear**

This command removes the contents within a selection in the Edit window.
**Cut Special**

The Cut Special commands let you cut just automation data from the current selection (without associated audio, video, or MIDI notes) and place it in memory to paste elsewhere. Choices include:

- **Cut Clip Gain** Cuts clip gain settings, so that you can apply the clip gain settings from one clip to any other. Clip gain settings cannot be cut across clip boundaries.

- **All Automation** Cuts all automation or MIDI controller data whether it is shown or not.

- **Pan Automation** Cuts only pan automation or MIDI pan data whether it is shown or not.

- **Plug-In Automation** Cuts only plug-in automation that is shown.

**Copy Special**

The Copy Special commands let you copy just automation data from the current selection (without associated audio, video, or MIDI notes) and place a copy of it in memory to paste elsewhere.

- **Copy Clip Gain** Copies clip gain settings, so that you can apply the clip gain settings from one clip to any other. Clip gain settings cannot be copied across clip boundaries.

- **All Automation** Copies all automation or MIDI controller data whether it is shown or not.

- **Pan Automation** Copies only pan automation or MIDI pan data whether it is shown or not.

- **Plug-In Automation** Copies only plug-in automation that is shown.

**Paste Special**

The Paste Special commands offers several options for pasting audio, MIDI, and automation data into another clip, in the following ways:

- **Merge** Pastes MIDI controller data from the clipboard to the selection and merges it with any current MIDI controller data in the selection. This can be useful for consolidating MIDI data from several tracks into a single MIDI track.

- **Repeat to Fill Selection** Pastes multiple iterations of audio, video, or MIDI data from the Clipboard to fill the selection. If you select an area that is not an exact multiple of the copied clip size, the remaining selection area is filled with a trimmed version of the original selection. This allows you to easily create drum loops and other repetitive effects. Before the data is pasted, Pro Tools prompts you to specify a crossfade to smooth transitions between clips.

- **To Current Automation Type** Pastes the automation or MIDI controller data from the clipboard to the selection as the current type of automation or continuous MIDI data. This lets you copy one type of automation data to another, or one type of continuous MIDI data to another type of continuous MIDI data.

**Clear Special**

The Clear Special commands let you clear just automation data from the current clip. Choices are:

- **Clear Clip Gain** Clears the clip gain settings for the current Edit selection. This resets the clip gain for selection to 0 dB. For clips only partially included in the Edit selection, only the clip gain settings within the Edit selection are affected.
**All Automation** Clears all automation or MIDI controller data whether it is shown or not.

**Pan Automation** Clears only pan automation or MIDI pan data whether it is shown or not.

**Plug-In Automation** Clears only plug-in automation that is shown.

**Select All**

This command selects all audio and MIDI data in one or more tracks.

- To select all clips in a single track, select a portion of the track, or click the Selector anywhere in a track and choose Select All.

- To select all clips on multiple tracks, Shift-click a clip on each track with the Selector or Grabber and choose Select All.

- To select all clips on all tracks, Select the “All” Edit Group in the Groups List, click the Selector anywhere in a track, and choose Select All.

**Selection**

The Selection commands are for copying or playing Edit or Timeline selections.

**Change Timeline to Match Edit** When the Edit and Timeline selections are unlinked, this command copies the current Timeline selection to the Edit selection.

**Change Edit to Match Timeline** When the Edit and Timeline selections are unlinked, this command copies the current Edit selection to the Timeline.

**Play Edit** This command plays an Edit selection.

**Play Timeline** This command plays a Timeline selection.

**Duplicate**

This command copies a selection and places it immediately after the end of that selection in a track.

**Repeat**

This command is similar to Duplicate, but allows you to specify the number of times the selected material is duplicated. To use this command, select the material you want to repeat, choose Repeat, then enter the number of repetitions.

**Shift**

This command moves track material earlier or later in time by a specified amount. To use this command, select the material you want to move, choose Shift, then enter the direction and time value.

**Insert Silence**

This command creates clips of silence. Make a selection on one or more tracks, choose Insert Silence, and precisely that amount of silence will be inserted. The Insert Silence command also inserts video black into a video track.

**Snap To**

This command provides two options for “butt splicing” successive elements on a track.

**Next** Snaps a clip (or Edit selection containing whole clips) to the beginning of the next clip in a track.

**Previous** Snaps a clip (or Edit selection containing whole clips) to the end of the preceding clip.
Trim Clip

This command provides several options for editing clip boundaries (including looped clips).

**To Selection**  This command removes data before and after a clip or MIDI note selection, leaving only the selection. This command lets you quickly remove all data in a clip (and in some instances the entire track) except for the current selection.

When trimming clips that include fades or are adjacent to fade boundaries, the fades from the source clip are adjusted to the new clip boundaries.

**Start to Insertion**  This command lets you trim a clip or MIDI note by automatically removing the material between the Edit insertion point and the start point.

**End to Insertion**  This command lets you trim a clip or MIDI note by automatically removing the material between the Edit insertion point and the end point.

**Start to Fill Selection**  This command lets you automatically reveal underlying material in the gaps between the clip start and selection start points.

**End to Fill Selection**  This command lets you automatically reveal underlying material in the gaps between the selection end and clip end points.

**To Fill Selection**  This command lets you automatically reveal underlying material in the gaps before and after the selection.

Separate Clip

These commands separate a clip from adjacent data in the track where it was created. By separating a clip, you will also create by-product clips from data on either side of the separation. The Separate Clip commands automatically unloops and flattens looped clips before separating.

Separate Clip includes the following commands:

**At Selection**  This command creates new clip boundaries at the selection start and end points.

When separating clips that include fades, the status of the fade depends on the Preserve Fades when Editing preference.

**On Grid**  This command constrains newly created clips to start and end on grid points.

**At Transients**  This command automatically creates clip boundaries on detected transients within a selection.

Heal Separation

This command repairs separated clips, provided that the clips are contiguous and their relative start and end points haven’t changed since they were originally separated. You can Heal Separation between two clips if you have trimmed or changed the start and end points, but not if you have moved the clips themselves.

Consolidate

This command consolidates multiple clips into a single clip. When audio clips are consolidated, a new audio file is written that encompasses the selection range, including any blank space, fades, or clip gain settings.
**Mute/Unmute Clip**

This command mutes playback of a selected clip. Choosing the Unmute command unmutes the clip. This command does not create automation data.

💡 *The clip appears greyed out when muted.*

**Copy Selection To**

In Playlists Track view, these commands copy the current edit selection and paste it to the Main Playlist, a New Playlist, or a Duplicate Playlist at the same time location.

**Copy Selection To Main Playlist** Copies and pastes the selection to the main playlist. Any material already on the main playlist at the same location is overwritten.

**Copy Selection to New Playlist** Creates a new, empty main playlist and copies and pastes the selection to the new main playlist.

**Copy Selection to Duplicate Playlist** Duplicates the current main playlist and copies and pastes the selection to the duplicate of the main playlist. The previous main playlist moves to a new Playlist lane.

**Strip Silence**

This command opens the Strip Silence window. Use this window to remove areas of silence from a selection. Strip Silence automatically divides a selection into clips, which can be useful for quantizing audio to musical values or SMPTE locations.

**TCE Edit to Timeline Selection**

This command uses the Time Compression/Expansion plug-in to fit an audio selection to a Timeline selection. This is only possible when the Edit and Timeline selections are unlinked.
**Automation**  
**(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)**

**Copy to Send**

This command lets you copy either the current values or automation of a selected track’s volume, pan, mute, or LFE automation to the corresponding playlist for the send. This is useful when you want a track’s send automation to mirror automation on the track itself.

![Copy to Send dialog](image)

*Copy to Send dialog*

To copy a track’s current control settings to a send on that track, select **Current Value**. To copy the entire automation playlist for the track to a send, select **Automation**.

**Thin**

This command lets you selectively thin areas in a track where automation data is too dense and adversely affecting CPU performance. The amount of thinning performed is determined by the amount you have selected in the Automation page of the Preferences dialog. Avoid over-thinning data or it may no longer accurately reflect the original automation.

**Thin All**

This command lets you thin all automation in a track. The amount of thinning performed is determined by the amount you have selected in the Automation page of the Preferences dialog. Avoid over-thinning data or it may no longer accurately reflect the original automation.

**Convert Volume Automation to Clip Gain**

This command converts track-based volume automation to clip gain settings. Volume automation is cut from the track volume automation playlist and pasted to the clip. Once volume automation has been converted to clip gain, the clip gain settings stay with the clip when moved, cut, copied, or pasted.

**Convert Clip Gain to Volume Automation**

This command converts clip gain settings to track-based volume automation. Clip gain settings are cut from the clip and pasted to track-based volume automation at the same timeline locations as the clip.

**Coalesce Volume Automation to Clip Gain**

This command coalesces track-based volume automation to clip gain settings. Volume automation is cut from the track volume automation playlist and coalesced with the selected clip gain settings.

After volume automation has been coalesced, it is set to 0 dB in the selection.
Coalesce Clip Gain to Volume Automation

This command coalesces clip gain settings to track-based volume automation. Clip gain settings are cut from the clip and coalesced with track-based volume automation at the same timeline locations as the clip.

Write to Current and Write to All Enabled
(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

These commands let you write automation states for one or more parameters to specific session locations in a single step. This saves you the trouble of performing multiple automation passes for different parameters in real time, or having to graphically draw automation state changes on individual automation playlists.

Write to Current Parameters

This command writes the current value only to the currently displayed automation parameter.

Write to All Enabled Parameters

This command writes the current settings for all automation parameters enabled in the Automation Enable window.

Trim to Current and Trim to All Enabled
(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

These commands let you use trim values as snapshots and apply the relative changes (or delta values) to the selected automation. This is similar to the Write Automation command, except that it writes delta values instead of absolute values to automation data. You can use trim values in writing snapshot automation to any automatable parameter.

Trim to Current Parameter

This command trims the current value only to the currently displayed automation parameter.

Trim to All Enabled Parameters

This command trims the current settings for all automation parameters enabled in the Automation Enable window.

Glide to Current and Glide to All Enabled
(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

These commands let you manually create an automation transition (or glide) from an existing automation value to a new one, over a selected area.

💡 Glide Automation can also be used for automating the Surround Panner.

Glide to Current Parameter

This command applies Glide Automation only to the currently displayed automation parameter.

Glide to All Enabled Parameters

This command applies the Glide Automation for all automation parameters enabled in the Automation Enable window.
**Fades**

These commands let you create (or delete) a crossfade between two adjacent audio clips, or a fade-in or fade-out of a single clip. Crossfade duration, position, and shape are all selectable. A selection that crosses multiple clips will create crossfades for each of the clip transitions. If a selection includes clips that already contain crossfades, the existing crossfades will be modified.

**Create** The Create command produces a crossfade between adjacent clips according to parameters you specify with the Fades editor.

**Delete** The Delete command removes a crossfade between adjacent clips.

**Fade to Start** The Fade to Start command creates a fade-in from the current insertion point to a clip’s start point.

**Fade to End** The Fade to End command creates a fade-out from the current insertion point to a clip’s end point.
Chapter 5: View Menu

View menu options and commands control the display of Pro Tools windows, tracks, and track data. Some View menu options toggle the display of various Pro Tools windows or data: selecting the option displays the data, and deselecting the option hides the data.

Mix Window

These options selectively display the following views in the Mix window:

- Mic Preamps
- Instruments
- HEAT (Pro Tools|HD systems only)
- Inserts A–E
- Inserts F–J
- Sends A–E
- Sends F–J
- Delay Compensation
- Track Color
- Comments

You can also select All of the displays, or None of them.

Narrow Mix

This option reduces the width of Mix channel strips on-screen, allowing you to display the maximum number of tracks on your computer monitor. In this view, track names, names of sends, and plug-in names are abbreviated to accommodate the smaller view. To return to normal view width, deselect this option.

Edit Window Views

These options selectively display the following views in the Edit window:

- Comments
- Mic Preamps
- Instruments
- Inserts A–E
- Inserts F–J
- Sends A–E
- Sends F–J
- I/O
- Real-Time Properties
- Track Color

You can also select All of the displays, or the Minimal number of displays (Track Color only).
**Rulers**

These options selectively display various Timebase and Conductor rulers in the Edit window. In addition to providing a timing reference for track material, Timebase rulers are used to define Edit and Timeline selections.

Besides selecting individual rulers, you can select All of the rulers, or the Minimal number of rulers (which is the main timebase ruler only).

**Timebase Rulers**

Any or all of the following Timebase rulers can be displayed at the top of the Edit window:

- Bars:Beats
- Minutes:Seconds
- Timecode
- Timecode 2
- Feet+Frames
- Samples

In addition to providing a timing reference for track material, the Timebase rulers are also used to define Edit selections for track material, and Timeline selections for record and play ranges.

**Conductor Rulers**

Any or all of the following Conductor rulers can be displayed:

- Markers
- Tempo (and Tempo Editor)
- Meter
- Key Signature (and Key Signature Staff)
- Chord Symbols

The Tempo, Meter, Key Signature and Chord Symbols rulers indicate changes in tempo, meter, key signature, and chords within the session. The Markers ruler displays Markers to important track locations.

The Tempo Editor is an expansion of the Tempo ruler, opening in the rulers section of the Edit window.

You can show or hide the Key Signature Staff in the Key Signature ruler.

**Other Displays**

These options let you show or hide the Universe view, the Track List, Clip List, or the MIDI Editor. A check mark indicates an open display.

**Universe** The Universe view displays an overview of the entire session, representing audio and MIDI material on all tracks that are not hidden (including tracks that are inactive, or that contain offline clips). The order in which material is displayed in the Universe view corresponds to the track order in the Edit window.

In the Universe view, audio, MIDI, and video clips on tracks are represented by horizontal lines that are the same colors as the clips on the tracks. Additionally, each channel in a stereo or multichannel audio track is represented individually.

**Track List** This option shows or hides the Track List.

**Clip List** This option shows or hides the Clip List.

**MIDI Editor** This option opens a MIDI Editor docked within the Edit window. This option appears grayed out if no MIDI editor window is available.
Clip

These options selectively display various data in clips.

**Sync Point** This option lets you display or hide sync points in clips. Clips will align to a sync point regardless of its display status.

**Processing State** This option lets you display or hide the Processing State Indicator on Elastic Audio clips. When selected, any clips on Elastic Audio–enabled tracks that have been warped or transposed display the Processing State Indicator icon.

**Name** This option lets you display or hide clip names in tracks in the Edit window. Hiding a display is useful if you are working at a zoom level where clip names obscure the view of audio waveforms.

**Channel Name** This option lets you display or hide channel names in clips.

**Scene and Take** This option lets you display or hide scene and take information in clips.

**Rating** This option lets you display the ratings given to clips.

**Clip Gain Line** This option lets you edit the clip gain settings for any given clip using breakpoint editing, much like with track-based volume automation.

**Clip Gain Info** This option lets you show or hide the Clip Gain icon.

**Overlap** This option lets you display or hide the clip overlap “dog-ear” corner that indicates overlapping clip boundaries.

**Current Time** This option displays the time stamp of all clips placed in all tracks according to their current location in the track.

**Original Time Stamp** This option displays the Original Time Stamp of all clips in all tracks. When a clip is created, it is time stamped relative to the SMPTE start time specified for the session. This original time stamp is permanently stored with the clip and cannot be changed. If a clip is ever moved, it can easily be placed at its original position using the Spot dialog.

**User Time Stamp** This option displays the User Time Stamp of all clips in all tracks. When a file is first recorded, its User Time Stamp is identical to its original time stamp. You can change the User Time Stamp using the Time Stamp Selected command in the Clip List. This allows you to use a custom time stamp for spotting or re-spotting the clip to a time location different from its Original Time Stamp.

**No Time** This option disables the time stamp display in clips.

**Display on All Channels** This option displays the selected Clip display option on all channels of a multi-channel clip that was imported from a field recorder.
Waveforms

These options define how waveforms are displayed and calculated. Waveforms can be displayed normally (as positive and negative shapes around the zero crossing) or rectified. They can also be calculated as Peak or Power, whether displayed normally or rectified. Any waveform can have an Outline.

**Peak** When selected, the waveform display is calculated based on the sample-by-sample peak level. Peak view is traditionally how Pro Tools calculates the waveform overview and can be used for normal or rectified views. Peak view clearly displays any clipping in the waveform.

**Power** When selected, the waveform display is calculated according to the Root Mean Square (RMS). Power view can be used for normal or rectified views. When zoomed in to the sample level, Pro Tools always displays Peak view, but Power view is useful for better seeing the characteristics of the audio in the waveform representation when zoomed out beyond the sample level. For mastering applications in particular, it can be more revealing of the sonic characteristics of the audio than Peak view.

**Rectified** When selected, audio waveforms are displayed so that their positive and negative waveform excursions (the portions that fall above and below the center line) are summed together and viewed as a single positive-value signal. This view allows more waveform detail to be seen in either normal or reduced track height views. It can be particularly useful when editing volume automation data, since it depicts waveform levels as starting at the bottom of the track. Rectified Waveform view is an option that can be enabled in Peak or Power views.

**Outlines** When selected, audio waveforms are outlined.

**Overlapped Crossfades** When selected, audio waveforms are displayed to show the fade in and fade out waveforms in crossfades.

Automation

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

These options let you display automation data (in addition to the main automation data displayed in certain automation playlists).

**Trim Playlist** If automation is not set to coalesce after every automation pass, this command displays Trim automation data along with the main Volume or Send level automation data in the same automation view. This Trim automation display cannot be directly edited.

**Composite Playlist** When a track is a VCA slave, you can display a composite automation playlist that shows the contribution of the VCA Master to the Volume or Mute automation data on the slave track. This composite playlist reflects the actual position of the Volume fader on the slave track. The composite playlist display cannot be directly edited.
Sends A–E

These options display either send assignments for all sends, or the controls for individual sends (Sends A–E). Select Assignment to display all five of these send assignments.

Sends F–J

These options display either send assignments for all sends, or the controls for individual sends (Sends F–J). Select Assignment to display all five of these send assignments.

Track Number

This command assigns each track a number corresponding to its position in the Mix and Edit windows. When tracks are reordered, track numbers stay in positional sequence.

Transport

These options selectively display Counters, MIDI Controls, Synchronization, and Expanded controls in the Transport window.

Main Counter

These view options set how the Time Scale is displayed in the Main Counter.

Bars:Beats This option displays the Time Scale in Bars and Beats. Use this Time Scale if you are working with musical material that must align with bars and beats.

Minutes:Seconds This option displays the Time Scale in minutes and seconds.

Timecode (Pro Tools HD and Pro Tools with Complete Production Toolkit Only) This option displays the Time Scale in SMPTE frames. The Frame Rate and Session Start time are set from the Session Setup window. Pro Tools supports the following frame rates: 24, 25, 29.97 Non-Drop, 29.97 Drop, 30 Non-Drop, and 30 Drop frames per second.

Feet+Frames (Pro Tools HD and Pro Tools with Complete Production Toolkit Only) This option displays the Time Scale in feet and frames for referencing audio-for-film projects. The Feet+Frames time display is based on the 35 millimeter film format.

Samples This option displays the Time Scale in samples. This format is useful for high-resolution sample editing.
Chapter 6: Track Menu

Track menu commands are used to create, manage, and edit tracks.

New

The New command lets you add one or more new audio tracks, Auxiliary Inputs, Master Faders, VCA Masters, MIDI tracks, Instrument tracks, or Video tracks to a session.

Audio tracks, Auxiliary Inputs, and Master faders can be mono or stereo, or a greater-than-stereo multichannel format (Pro Tools HD and Pro Tools with Complete Production Toolkit only).

Group

This command opens the Group dialog, which lets you create, modify, duplicate, delete, and assign attributes to groups.
**Duplicate**

This command lets you define how many copies of a track you want to create, and specifies whether to copy audio or MIDI data, playlists, automation, and other attributes.

When duplicating multiple tracks, you can also choose to have the new tracks follow the last selected track (or have each new track follow its source track).

Duplicating a VCA slave track without duplicating its group assignments will coalesce any automation the duplicate track. The coalesced duplicate plays back exactly as if it were in the VCA group.

**Split into Mono**

This command splits a selected stereo or multi-channel track into individual mono tracks that can be edited and manipulated independently. The Split into Mono command cannot be undone.

**Make Inactive or Make Active**

This command makes selected tracks inactive, so that they no longer play back or use any DSP resources or voices. Inactive tracks can be made active again by choosing the Make Active command.

**Delete**

This command removes tracks from a session. While audio or MIDI clip data will remain in the Clip List, the track and its arrangement of the clips on the deleted track (the track’s playlist) will be lost.

If the track contains playlists that are not assigned to any track, you will be prompted to delete or retain them.

Deleting a VCA Master track will coalesce automation from the VCA Master to all of its slave tracks.

**Write MIDI Real-Time Properties**

This command applies MIDI quantization, duration, delay, velocity, and transposition parameters during playback, as set in Real-Time Properties View (in the Edit window) or in the MIDI Real-Time Properties dialog.
Set Record Tracks to Input Only or Set Record Tracks to Auto Input
(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

Set Record Tracks to Input Only

This command changes all record enabled tracks to monitor audio input only, regardless of any punch in or out selection.

Set Record Tracks to Auto Input

This command changes all record enabled tracks to automatically switch from monitoring input signals to monitoring recorded tracks. When set, record enabled tracks monitor audio input when the transport is stopped. When playback is started for a punch-in, Pro Tools monitors existing track material up until the punch point. While punched in, the input signal is monitored. On punch-out, monitoring switches back to the existing track material. This is similar to the auto-switching logic found on digital and analog multitrack tape machines.

Auto Input Monitoring or Input Only Monitoring
(Pro Tools Only)

Auto Input Monitoring

In this mode, when session playback is stopped, Pro Tools monitors audio input. When playback is started for a punch-in, Pro Tools monitors existing track material up until the punch point. While punched in, the input signal is monitored. On punch-out, monitoring switches back to the existing track material. This is similar to the auto-switching logic found on digital and analog multitrack tape machines.

Input Only Monitoring

In this mode, when a track is record-enabled, Pro Tools monitors audio input only.

Scroll To Track

This command lets you scroll directly to any track by position number. The Edit window tracks will scroll to bring the selected track to as close to the top as possible, and the Mix window tracks will scroll to bring the selected track as close to the left as possible.
Clear All Clip Indicators

This command clears all clip indication from all meters.

Coalesce VCA Master Automation

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

This command lets you commit, or *coalesce*, the contribution of a selected VCA Master track’s Volume and Mute automation to the automation playlists of its slave tracks (or VCA automation across an Edit selection).

Clear Trim Automation

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

This command lets you clear Trim automation if it has not been coalesced on a track. When you clear Trim automation, automation breakpoints on all Trim playlists are deleted and all Trim faders are reset to zero.

Coalesce Trim Automation

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

This command applies, or *coalesces* Trim automation to the main automation playlist by the following methods: After Every Pass, On Exiting Trim Mode, or Manually.

Create Click Track

This command lets you create one or more click tracks. Click tracks are Auxiliary Input tracks with the Click plug-in already inserted.
Clip menu commands are used to manage and edit clips.

### Edit Lock/Unlock

This command lets you Edit-lock a clip or group of clips that you want to protect from being inadvertently edited. Clips that are Edit-locked cannot be edited (such as cutting, deleting, separating, or trimming) or moved to a different time location. Copied edit-locked clips can be pasted to any track or time location, but the copy will also be Edit-locked at the new time location.

### Time Lock/Unlock

This command lets you lock to a particular location in a track (a beat, SMPTE frame, or sample location), so it cannot be moved accidentally. Time-locked clips cannot be moved or deleted. However, they can be edited in ways that do not delete or move the clip’s sync point to a different time location (such as separating, trimming, AudioSuite™ processing, or even moving the clip to another track). When separating a Time-locked clip, any new clips will also be locked to their time locations.

### Send to Back

This command sends the selected clip or clips behind any neighboring overlapping clips. If multiple overlapping clips are selected, Pro Tools will apply the command to each clip as that clip relates to the neighboring clip on the right.

### Bring To Front

This command brings the selected clip or clips to the front of any neighboring overlapping clips. If multiple overlapping clips are selected, Pro Tools will apply the command to each clip as that clip relates to the neighboring clip on the right.

### Rating

This command lets you rate different clips on a scale of 1 to 5, where 5 is the highest and 1 is the lowest. You can also give clips no rating (“none”). This is the default rating.

Clip rating is useful for identifying which takes (clips) you like the most when compositing playlists. You can display or hide the clip rating in clips to facilitate track compositing or regular editing. You can also show or hide Playlist lanes based on the ratings of clips in the playlist.
Group

The Group command creates a clip group from all elements in the current selection. Selections can include audio, MIDI, or Video clips on one or more tracks. Multiple clip groups can be selected and included in new clip groups.

Ungroup

The Ungroup command unpacks the currently selected clip group, revealing all underlying clips and any nested clip groups. When there are multiple nested clip groups, the Ungroup command will ungroup the front-most top-layer clip group only, preserving any underlying clip groups.

You can also use the Clip > Ungroup command on looped clips to unloop and maintain all loop iterations as individual clips.

Ungroup All

The Ungroup All command removes all layers of clip groups and nested clip groups in the currently selected clip in one step.

You can also use the Clip > Ungroup All command on looped clips to flatten the looped clips into one clip.

Regroup

The Regroup command undoes the last Ungroup command and regroups the individual clips back to their former clip group state. This lets you ungroup a grouped clip, edit its underlying clips, and regroup it to continue working on higher-level composition and arranging.

Loop

The Loop command lets you loop audio, video, and MIDI clips.

Unloop

The Unloop command lets you switch looped clips back to standard (unlooped) clips so that they can be edited individually.

Capture

This command defines a selection as a new clip and adds it to the Clip List. From there the new clip can be dragged into a track. You cannot capture selections across multiple clips unless the data is contiguous material from the same file.

Rename

This command lets you rename the selected clip. When renaming a clip that was auto-created during editing, the clip becomes a user-defined clip and is displayed in the Clip List even when auto-created clips are hidden.
Identify Sync Point and Remove Sync Point

This command places a Sync Point at the current cursor location. When you identify a sync point, a small down arrow appears at the bottom of the clip, with a vertical, light grey line indicating the location of the sync point. This Sync Point can then be used as the reference point—nudge, spot, move, and so on—instead of the clip start or end. When you choose this command, the current SMPTE time is automatically entered as the SMPTE location for the Sync Point.

To remove a Sync point from a clip, select the clip with the Grabber and choose Clip > Remove Sync Point.

Clip Gain

Pro Tools provides separate commands for bypassing and rendering clip gain.

Bypass Clip Gain

This command lets you toggle the bypass state of selected clips. When clip gain settings are bypassed, the clip is played without gain adjustments, but settings are preserved.

Render Clip Gain

This command applies clip gain settings to the corresponding audio and resets the clip gain to 0 dB.

Quantize to Grid

This command adjusts the placement of a selected audio or MIDI clip in a track so that its start point (or Sync Point, if it contains one) precisely aligns to the nearest Grid boundary. Grid units are chosen from the Grid pop-up menu in the Edit window.

Elastic Properties

This command lets you view the Elastic Audio properties of any clip on an Elastic Audio–enabled track. You can also edit Event markers for Elastic Audio.
Conform to Tempo

This command lets you conform clips on Elastic Audio–enabled tracks (both sample- and tick-based) to the session tempo. If necessary, the Conform to Tempo command analyzes the selected clip to determine its tempo and duration (in bars and beats), and then applies Elastic Audio processing to conform the clip to match the session tempo.

Remove Warp

This command removes warping applied to a clip, but leaves underlying Warp markers intact. This feature will only remove warping created by Warp markers (that is, warping caused by quantization or tempo mapping). This can be useful if you are not satisfied with the results and want to revert to the pre-warped clip.

Remove Pitch Shift

This command removes pitch shifts applied to Elastic Audio–enabled clips using the Pitch Shift option in the Elastic Properties dialog.
Chapter 8: Event Menu

The Event menu contains commands for editing audio and MIDI events.

Time Operations

Pro Tools provides several commands for defining meter and time over a range of time (or measures).

Time Operations Window

This command opens the Time Operations window. This floating window lets you define meter, click, and song start options by choosing any of the following commands from the pop-up menu at the top of the window:

- Change Meter
- Insert Time
- Cut Time
- Move Song Start

Time Operations window, Change Meter option
**Change Meter**

The Change Meter command lets you specify complex meter changes for Bar|Beat-based material. You can enter meter changes at a particular bar, make a meter change over a selected area of time, or add meter changes sequentially one bar at a time.

**Insert Time**

The Insert Time command lets you insert an amount of blank time into conductor rulers, MIDI tracks, and audio tracks.

**Cut Time**

The Cut Time command lets you cut a specified amount of time from conductor rulers, MIDI tracks, and audio tracks.

**Move Song Start**

The Move Song Start command lets you redefine the location of the Song Start Marker.
**Tempo Operations**

Pro Tools provides several commands for defining tempo events over a range of time (or measures).

**Tempo Operations Window**

This command opens the Tempo Operations window. This window lets you define tempo events over a range of time (or measures) by choosing any of the following commands from the pop-up menu at the top of the window:

- **Constant**
- **Linear**
- **Parabolic**
- **S-Curve**
- **Scale**
- **Stretch**

**Constant**

This command lets you create a constant tempo over a selected range of time.

**Linear**

This command lets you create tempos that change evenly over a selected range of time.

**Parabolic**

This command lets you create tempos that accelerate or decelerate following a tempo curve, which changes the tempo more rapidly or less rapidly over the selection time.

**S-Curve**

This command lets you create tempos that accelerate or decelerate following a tempo curve with a definable breakpoint that determines mid-curve times and tempo values.

**Scale**

This command lets you scale tempos within the selection by a percentage amount.

**Stretch**

This command lets you select a group of contiguous tempo events and expand or compress them into a larger or smaller selection area.
Event Operations

Pro Tools provides several commands for changing event data over a range of time (or measures).

Event Operations Window

The Event Operations window provides commands to transform groups of MIDI notes to affect pitch, timing, and phrasing. The Quantize and Restore Performance Event Operations can also be applied to audio clip start points (or sync points) or Elastic Audio events. The Event Operations commands include:

- Quantize
- Change Velocity
- Change Duration
- Transpose
- Select/Split notes
- Input Quantize
- Step Input
- Restore Performance
- Flatten Performance

Quantize

This command lets you adjust the placement of selected MIDI or audio events in a track using Grid or Groove Quantize.

Event Operations window, Transpose page

Event Operations window, Quantize page

Quantize lets you choose from two different types of quantization.

- Grid Quantize lets you adjust the placement of selected MIDI events, Elastic Audio events, or audio clips in a track so that their start or end points precisely align to the quantization value chosen.

- Groove Quantize lets you adjust the placement of selected MIDI events, Elastic Audio events, or audio clips in a track so that their timings, durations, and velocities align to the selected groove template grid. Pro Tools installs several pre-defined groove templates for use on all Pro Tools systems. DigiGroove templates can be created using Beat Detective.
**Change Velocity**

This command lets you automatically adjust Note On (attack) and Note Off (release) velocities for selected MIDI notes. Use it to make notes louder or softer, or to create a crescendo or diminuendo.

![Event Operations window, Change Velocity page](image)

**Change Duration**

This command lets you adjust the duration for selected MIDI notes. It can be used to make melodies and phrases more staccato or more legato.

![Event Operations window, Change Duration page](image)

**Transpose**

This command transposes selected MIDI notes in key up or down by scale steps.

![Event Operations window, Transpose page](image)
Select/Split Notes

The Select/Split Notes command provides tools to do the following:

- Select MIDI notes based on pitch, velocity, duration, and position. These controls can be used to select a single note or note range for the entire length of a clip or track.
- Split selected note and controller to the clipboard, to new tracks, or multiple new tracks based on pitch (one new track is created for each different pitch in the selection).

The Select/Split Notes window can be used to quickly extract a melody line from a keyboard performance. Or, select a drum kit or similar multi-voice performance track and automatically create multiple new tracks, one for each pitch in the selection.

Input Quantize

This command lets you quantize MIDI notes as they are performed and recorded. While this will improve the strict rhythmic accuracy of a performance, it can also give it a stiff, mechanical feel. To preserve the original rhythmic nuances of a performance, experiment with lower Strength settings, or deselect the Enable input quantize option.

Event Operations window, Input Quantize page

Event Operations window, Select/Split Notes page
**Step Input**

This command lets you use a MIDI controller to enter notes individually, one step at a time. This gives you precise control over note placement, duration, and velocity. With MIDI step input you can also create musical passages that might be difficult to play accurately, or at a fast tempo.

**Restore Performance**

This command lets you restore the original MIDI or audio performance regardless of how many edits you have made or whether or not the undo queue has been cleared (for example, by saving the session). Restore Performance can also be applied to quantized Elastic Audio Events or quantized audio clips.

For MIDI, one or more of the following note attributes can be restored: Timing (Quantization), Duration, Velocity, and Pitch. For audio, only Timing (Quantization) can be restored.

**Flatten Performance**

This command lets you lock the specified current note parameters as the “restore to” state, overriding the original performance. One or more of the following note attributes can be flattened: Timing (Quantization), Duration, Velocity, and Pitch. Flatten Performance can be undone.
MIDI Track Offsets

This command opens the MIDI Track Offsets window. This window lets you create timing offsets for MIDI tracks to compensate for MIDI-to-audio latencies in hardware-based or software-based MIDI synthesizers.

By configuring a MIDI offset, you can make MIDI tracks play back slightly earlier (by a specific number of samples), thereby compensating for any audio monitoring latencies. MIDI offsets affect playback only and do not alter how MIDI data is displayed in the Edit window.

MIDI Real-Time Properties

This command opens the Real-Time Properties window. This window lets you adjust and apply MIDI quantization, duration, delay, velocity, and transposition parameters during playback.

Remove Duplicate Notes

The Remove Duplicate Notes command lets you quickly identify and remove MIDI notes that were unintentional “double-hits.”

If a note starts within the first 25% of the duration of a note of the same pitch which is already sounding (or within an eighth-note, whichever is shorter), it is considered a duplicate and is combined with the previous note. If a note starts later than 25% of the duration, it is considered to be a new, distinct note, and is shortened so that it ends at the same tick at which the next note starts.

Add Key Change

This command opens the Key Change dialog, which lets you specify the mode (major or minor), the key (from seven flats to seven sharps), the range affected (for example, from Bar 1 to the next key change), and whether existing notes on pitched MIDI and Instrument tracks are transposed.
Beat Detective

This command opens the Beat Detective™ window. Beat Detective automatically detects the tempo of a session and conforms an audio track or selection to that tempo by separating it into clips and aligning it to the beats. Beat Detective is ideal for tailoring a performance to a groove. For detailed information about Beat Detective, refer to the Pro Tools Reference Guide.

Identify Beat

This command lets you establish a tempo/meter map for audio that was recorded without listening to a click, or for imported audio with unknown tempos.

The Identify Beat command analyzes a selection range (usually with a distinct number of beats or measures) and calculates its tempo based on the specified meter. In doing this, Bar|Beat markers for the calculated tempo are inserted and appear in the Tempo Ruler at the beginning and end of the selection. In addition, meter events are inserted into the Meter Ruler.

Renumber Bars

This command lets you renumber the bars in the session, effectively changing the bar locations for all clips, meter and tempo events while leaving their position intact. In doing so, however, the SMPTE and sample locations of the session data are not changed.

All MIDI Notes Off

This command sends an All Notes Off MIDI message to all MIDI devices connected to your system to silence any stuck notes.
Chapter 9: AudioSuite Menu

The AudioSuite™ menu lets you access all AudioSuite plug-ins currently installed in your system’s Plug-Ins folder. These include free Avid Effects plug-ins installed with Pro Tools.

AudioSuite plug-ins are non-real-time, file-based processing plug-ins for Pro Tools.

Plug-ins are located in the AudioSuite menu by category. This menu includes the following plug-in categories:

- EQ Plug-Ins
- Dynamics Plug-Ins
- Pitch Shift Plug-Ins
- Reverb Plug-Ins
- Delay Plug-Ins
- Modulation Plug-Ins
- Harmonic Plug-Ins
- Noise Reduction Plug-Ins
- Instrument Plug-Ins
- Other Plug-Ins

For more information on AudioSuite plug-ins, refer to the Audio Plug-Ins Guide.

Avid Marketplace

The Avid Marketplace option (for plug-ins) lets you find Pro Tools plug-ins in the online Avid Store for rent or purchase.
Chapter 10: Options Menu

The Options menu commands let you select several editing, recording, monitoring, playback, and display options.

Destructive Record

Destructive Record mode lets you record over existing clips and replace the original audio permanently. This lets you conserve hard drive space. However, if you have sufficient drive space, it is usually best to disable Destructive Record mode, and use Pro Tools in Nondestructive Record mode to avoid losing any previously recorded material.

Loop Record

Loop Record lets you record take after take while the same section of audio repeats. This is a convenient technique for quickly recording multiple takes of a part without losing spontaneity.

The time range that is looped and recorded—which must be at least one second in length—is defined by selecting a range in the Ruler or in a track’s playlist, or by specifying start and end points in the Transport window.

QuickPunch

QuickPunch™ lets you instantaneously punch-in (initiate recording) on a record-enabled audio track during playback, then punch-out (exit recording) by clicking the Transport’s Record button. Recording with QuickPunch is nondestructive.

TrackPunch

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

TrackPunch lets you punch individual tracks in, punch individual tracks out, and take tracks out of record enable without interrupting online recording and playback. Recording with TrackPunch is nondestructive.

DestructivePunch

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

Destructive Punch is a destructive recording mode that lets you instantaneously punch in (start recording) and punch out (stop recording) on individual audio tracks during playback, while preserving a contiguous audio file on each punched track. No additional clips are created when recording in DestructivePunch mode.
Prepare DPE (Destructive Punch-Enabled) Tracks

(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)

This command prepares a track for Destructive Punch recording by consolidating all Destructive-Punch-enabled tracks from the beginning of the session to the value specified in the Destructive Punch File Length preference.

Transport Online

This command arms the Pro Tools Transport for online synchronization. Playback or recording can then be triggered by an external timecode source. Online recording or playback begins as soon as Pro Tools receives and locks to timecode or ADAT sync.

Video Track Online

This command enables and disables playback of the main video track. You may want to give higher priority to screen updates for other Pro Tools tasks (such as metering, moving faders). With QuickTime movies, you may want to disable a video track to freeze the video at a particular point in time relative to Pro Tools playback.

Video Out FireWire

(QuickTime Movies Only)

This command plays the current QuickTime movie out the FireWire port. You may want to do this to have a Digital Video deck, monitor, or camcorder record or display DV (digital video) playback from Pro Tools.

For a list or supported DV FireWire transcoders, visit our website (www.avid.com).

Scrub in Video Window

This command opens a Scrub window, which displays the Avid video at quarter-resolution, but accurately scrubs the video. When the Scrub window is open, video output alternates automatically between the Scrub window and the video reference monitor depending on whether or not you are scrubbing.

When scrubbing, the video reference monitor is black. When leaving Scrub mode, the Scrub window disappears and video is routed to the video reference monitor.

The Scrub window is only available in Pro Tools systems with a qualified Avid DNA™ video peripheral (such as AOp- tion|V10 or Mojo®), and when there is Avid video or QuickTime video in the main video window.

Pre/Post-Roll

This option enables pre- and post-roll playback. Pre- and post-roll amounts can be entered in the Transport window, set from a track’s playlist or Timebase Ruler, or by recalling a Memory Location.
Loop Playback
This option continuously loops playback of a selection until you stop playback. Looping playback is a useful way to check the rhythmic continuity of a selection when working with musical material. Selections must be at least 0.5 seconds in length to use Loop Playback.

Dynamic Transport
This mode lets you decouple the playback start location from the Timeline selection. This means that you can start playback from anywhere on the Timeline without losing your Timeline or Edit selections. For example, you can use Dynamic Transport mode in conjunction with Loop Playback mode to quickly audition loop transitions.

Edit Window Scrolling
Pro Tools provides several options for defining how the contents of the Edit window scroll during playback and recording.

No Scrolling
The No Scrolling option disables scrolling during and after playback. With this option enabled, the playback cursor moves across the Edit window, indicating the playback location, up to the right edge of the Edit window. When the play point moves beyond the right edge of the Edit window, the Playback Cursor Locator icons appear at the right edge of the Main Timebase Ruler.

After Playback
The After Playback option causes the Edit window to scroll to the final playback location after playback has stopped. With this option enabled, the playback cursor moves across the Edit window, indicating the playback location.

Page
The Page option causes the Edit window to scroll during playback. With this option enabled, the playback cursor moves across the Edit window, indicating the playback location. When the right edge of the Edit window is reached, its entire contents are scrolled, and the playback cursor continues moving from the left edge of the window.

Continuous
(Pro Tools HD and Pro Tools with Complete Production Toolkit Only)
The Continuous option causes the Edit window’s contents to scroll continuously past the playback cursor, which remains in the center of the window. With this option enabled, playback is always based on the Timeline selection (Playhead).

Center Playhead
(Pro Tools HD Only)
This option causes the Edit window’s contents to scroll continuously past the Playhead, which is a blue line in the center of the window (red when recording).

Regardless of which Scrolling option is selected in the Options menu, Pro Tools does not scroll when zoomed down to the sample level.
Link Timeline and Edit Selection

This option lets you link or unlink any Timeline selection with any Edit selection.

When Link Timeline and Edit Selection is enabled, making a selection in a track’s playlist (an Edit selection) also defines the play and record range (the Timeline selection).

When Link Timeline and Edit Selection is disabled, you can make a selection within a track for editing purposes that is distinct from the selection in the Timeline (which determines the playback and recording range).

Link Track and Edit Selection

This option lets you link or unlink any track selection with any Edit selection.

When Link Track and Edit Selection is enabled, you can make an Edit selection within a track or across multiple tracks and each associated track is selected.

When Link Track and Timeline Selection is disabled, making an Edit selection does not automatically select all associated tracks.

Mirror MIDI Editing

This option lets you edit MIDI clips and have your edits automatically applied to every MIDI clip of the same name. This can be particularly useful when editing looped MIDI clips.

Automation Follows Edit

When this option is disabled, automation events are not affected by edits to audio or MIDI notes. When enabled, automation events are affected by edits to audio or MIDI notes.

Click

When the Click command is enabled, a metronome event is generated during playback and recording. The metronome can trigger an external MIDI device (as specified by the Output setting in the Click/Countoff Options dialog) or the DigiRack Click TDM or RTAS® plug-in (see the Audio Plug-Ins Guide).

MIDI Thru

Enabling the MIDI Thru command routes MIDI from your controllers to the devices and channels assigned to the MIDI track currently record-enabled. This lets you monitor MIDI tracks while recording.

Mute Frees Assigned Voice

(Pro Tools HD Only)

When this option is enabled, a muted track’s voice will be allocated to the next highest priority track assigned to the same explicit voice.
Auto-Spot Clips

When enabled, this option simplifies the task of spotting clips. If you are using VITC with this option enabled, or MachineControl™ software, you can pause your video at an appropriate SMPTE frame location, click on a clip with the Grabber, and the clip will be automatically spotted to the current timecode location.

Pre-Fader Metering

This option toggles track metering between pre- and post-fader operation. When set to Pre-Fader Metering, level meters show levels independent of fader position. With post-fader metering, the level meters respond to fader position. This option only affects on-screen meters.

Solo Mode

Pro Tools provides several modes and options for defining how track Solo buttons work.

Solo Modes
(Pro Tools HD Only)

Pro Tools provides several modes for defining how track Solo buttons work.

SIP (Solo In Place) When this mode is enabled, the Solo button mutes other tracks so that the chosen track can be auditioned alone.

AFL (After Fader Listen) When this mode is enabled, the Solo button routes the track’s post-fader/post-pan signal to the AFL/PFL Path output, which is set in I/O Setup.

PFL (Pre Fader Listen) When this mode is enabled, the Solo button routes the track’s pre-fader/pre-pan signal to the AFL/PFL Path output, which is set in I/O Setup.

⚠️ PFL Solo mode requires the Surround Mixer plug-in (see the Pro Tools Reference Guide for installation information).

Solo Latch Options

Pro Tools provides several latch options for defining how track Solo buttons work.

Latch When selected, pressing subsequent Solo buttons adds them to the soloed mix of tracks.

X-OR (Cancels Previous Solo) When selected, pressing subsequent Solo buttons cancels previous solos.

Momentary (Pro Tools HD Only) When selected, Solo buttons are not sticky. A track is soloed only when its Solo switch is held down.

Edit/Tool Mode Keyboard Lock

Enable this option to lock the ability to change tool types (for example, to change from the normal Trimmer to the Scrub Trimmer) using keyboard shortcuts. Tool types can still be changed using the mouse, and you can also still switch between tools (such as switching from the Grabber to the Trimmer) using keyboard shortcuts. This option affects the following Edit and Tool modes: Grid, Zoom, Trim, Grabber, and Pencil.

⚠️ AFL Solo mode requires the Surround Mixer plug-in (see the Pro Tools Reference Guide for installation information).
Calibration Mode
(Pro Tools HD Only)

Use Calibration Mode in Pro Tools to adjust the input and output levels for your audio interface (such as HD I/O or 192 I/O™) so they match those of your mixing console and other audio devices in your studio.

Delay Compensation

When this option is enabled, Pro Tools captures reported plug-in delays and signal routing for all tracks and calculates the correct delay for each track, compensating all the tracks accordingly.

Activate HEAT
(Pro Tools|HD Systems with the HEAT Software Option Only)

This command lets you apply HEAT to all active audio tracks in your session, emulating the effect of an analog mixing console. Use HEAT to open up your mixes with warm, analog-modeled soft-saturated distortion.

For more information about HEAT, see the HEAT Software Option Guide.

Low Latency Monitoring
(Pro Tools|HD Native, 003 Family, Digi 002, Digi 002 Rack, and Mbox 2 Pro Only)

This option lets you use the Low Latency Monitoring option to record with an extremely small amount of monitoring latency, to as many tracks as each system supports.
Chapter 11: Setup Menu

This menu provides commands to open dialogs and windows for configuring various Pro Tools hardware and software parameters.

Hardware

This command displays the Hardware Setup dialog, where you can specify settings for your hardware and sessions. Configure the settings for any audio interface connected to your Pro Tools system by selecting it from the Peripherals list.

The Main page of the Hardware Setup dialog can be used to define what physical ports are routed to Pro Tools input and output channels. The Main page also provides controls for Session Sample Rate and Clock settings.

With Pro Tools HD, additional pages can be used to configure other parameters on each audio interface (such as setting operating levels).

Playback Engine

This Playback Engine lets you set a hardware buffer size, define the RTAS Processors allocation on multi-processor computers, allocate a percentage of CPU resources for these tasks, and configure RTAS error reporting for playback and recording.

On Pro Tools|HD systems, you can select the number of voices and voiceable tracks for your system and its sessions. Voice count choices are based on how much DSP processing you want to allocate for voicing. If you change the Number Of Voices setting (Pro Tools HD only) mid-session, the session will be saved, closed, and reopened to enable the new settings.
**Disk Allocation**

If you are using multiple hard drives for recording, use the Disk Allocation dialog to assign each track in a session to a specific drive. Audio for that track will then be recorded to the chosen drive.

**Peripherals**

The Peripherals dialog provides several tabbed pages (Synchronization, Machine Control, MIDI Controller, Ethernet Controller, Microphone Preamp, Satellites, VENUE) for configuring various peripheral device for use with Pro Tools (such as SYNC HD™, Command|8®, or PRE™).

**Synchronization**

This page configures synchronization devices (such as SYNC HD) to synchronize Pro Tools to SMPTE Timecode or MIDI Timecode (MTC).
**MIDI Controllers**

This page configures MIDI control surfaces such as Command|8.

**Mic Preamps**

This page configures one or more PREs for use with Pro Tools.

**Ethernet Controllers**

This page configures D-Control, D-Command, C|24, or EUCON™ for use with Pro Tools.

**Satellite (Pro Tools HD Only)**

This page configures Pro Tools for the Video Satellite, Video Satellite LE, and Satellite Link options, which allow synchronization between Pro Tools and Avid video editing systems.
VENUE
This page configures Pro Tools for use with a VENUE system.

I/O
This I/O Setup dialog provides tools to label and map Pro Tools input, output, insert, bus signal, and Mic Preamp (PRE) paths. The I/O Setup dialog also lets you configure delay compensation for hardware inserts.

In addition, the I/O Setup dialog, like the Main page of Hardware Setup, provides controls for routing the physical ports on your audio interface (such as HD I/O) to Pro Tools Input and Output channels. The Output page of the I/O Setup dialog also lets you change the default path settings for Meter, Audition, and multichannel track layout (as displayed on-screen).

Machine Track Arming Profiles
(Pro Tools HD with MachineControl Option Only)
This dialog provides extensive control over Pro Tools Track Arming. You can customize arming, track naming and mapping, and save configurations for different machines as Track Arming Profile files. These Profiles can be imported to quickly reconfigure Track Arming as needed for future projects. You can also test track mapping, and remap tracks if needed.

Video Sync Offset
The Video Sync Offset dialog lets you offset video earlier or later in a session so you can accurately spot audio to it.

Avid Video Offset When playing Avid video through an Avid video peripheral, Pro Tools automatically compensates for the delay introduced by the peripheral. This means you can leave the setting at 0 frames and the output of the Avid video peripheral will be in sync with the audio. If you have a plasma monitor (which may introduce an additional delay of two frames), you can compensate for it by entering the amount of the delay here.
**QuickTime Video Offset** Pro Tools does not automatically compensate for the delay when playing QuickTime video through any FireWire peripheral, including Avid video peripherals. The amount of delay introduced varies based on your system and the type of video peripheral you are using. When using an Avid peripheral with QuickTime, 18 quarter-frames is a good starting point, but you will need to verify the precise setting for your system. (Third-party devices are available to help you measure this delay.)

**Session**

The Session Setup window lets you configure various timecode-related settings on your system, as well as certain session format settings (such as bit depth, pan depth, audio format, and interleaved).

The window also includes display-only areas for session sample rate, system delay, and timecode-related data (such as incoming time).

This dialog lets you specify a Feet+Frames value based on the current Edit cursor timecode location. Typically, this feature lets test tones, pre-roll, Academy leader, and similar pre-program material to be more easily integrated into Pro Tools sessions.

**Current Timecode Position**

This dialog lets you redefine the session start time. By creating an insertion point (or selection) and then entering the new timecode position for that location, the session start time will be recalculated based on the new, relative timecode location.

**Current Feet+Frames Position**

This dialog lets you specify a Feet+Frames value based on the current Edit cursor timecode location. Typically, this feature lets test tones, pre-roll, Academy leader, and similar pre-program material to be more easily integrated into Pro Tools sessions.
External Timecode Offset

This dialog lets you compensate for devices that are consistently offset by a fixed number of frames (such as some color-corrected video masters), or for material that starts at a different time than the session.

Pro Tools provides three different types of External Timecode Offset settings. These offsets include:

- MMC (MIDI Machine Control)
- 9-Pin (Serial machine control)
- Synchronization peripherals (such as the SYNC I/O, or a MIDI interface that provide MIDI Timecode).

Positive and negative offset values can be entered to offset Pro Tools timecode display later or earlier, respectively.

Unique values can be defined for each of these three types offsets, or you can link all three to adjust in unison.

MIDI

This dialog lets you set up your MIDI environment.

MIDI Studio

The MIDI Studio dialog launches the Apple Audio MIDI Setup application (Mac) or opens the MIDI Studio Setup window (Windows). These let you identify the MIDI devices connected to your MIDI interface.

MIDI Beat Clock

This dialog lets you enable synchronization for certain MIDI devices (such as drum machines, software synthesizers, and hardware sequencers) to MIDI Beat Clock. Devices selected in the MIDI Beat Clock dialog will receive the MIDI Beat Clock signal. If your MIDI interface does not support transmitting MIDI Beat Clock to separate ports, the interface will appear as the only destination.
**Input Filter**

This dialog provides settings for filtering out selected MIDI messages from your recording. The Input Filter can be set to record all messages, only the specified messages, or all except the specified messages. When using the Only option, only the MIDI messages that are selected will be recorded. Conversely, when using the All Except option, the selected messages will not be recorded.

**Input Devices**

This dialog enables selected MIDI controllers and control surfaces so that MIDI data received from them can be recorded. Disabling devices in this dialog will ensure that unwanted notes (such as those from drum machines or an arpeggiator) are not recorded.
Connect to SoundCloud
This dialog lets you log into your SoundCloud account from Pro Tools.

When logged into SoundCloud, you can use the Share With SoundCloud option in the Bounce to Disk dialog to upload bounced files directly to your SoundCloud account.

Click/Countoff
This dialog lets you configure metronome parameters such as MIDI note, velocity, duration, and output. If you are using the Click plug-in, set the output to None.

Preferences
This dialog determines how Pro Tools features work. The Preferences dialog has several pages in which you can specify settings for various session parameters.

💡 Pro Tools preferences are either global (apply to all sessions opened on the system) or local (apply to the current session only). For more information, see the Pro Tools Reference Guide.

Display Preferences Determine how windows, menus, tracks, meters, and color coding appear on-screen.

Operation Preferences Determine the behavior of the transport, numeric keypad modes, record modes, input monitoring, video playback, and session backup.

Editing Preferences Determine behavior when selecting and creating clips, creating fades, using Memory Locations, and zooming.

Mixing Preferences Determine the behavior of inserts, sends, pan controls, automation, and control surface banking.

Processing Preferences Determine behavior when importing audio, using AudioSuite plugins, and using Elastic Audio.

MIDI Preferences Determine behavior when displaying, editing and playing back MIDI data.

Synchronization Preferences Determine how a connected transport (using the MachineControl or Satellite Link option) responds to Pro Tools.
Chapter 12: Window Menu

The Window menu provides commands to toggle the display of various Pro Tools windows: selecting the command displays the window; selecting the command again hides the window.

💡 For Window menu items, keyboard shortcuts with number keys only work using the numeric keypad on your computer.

**Configurations**

The Configurations menu provides commands and options to manage the configuration of windows in your session, as well as the internal window configurations of the Edit, Mix, Transport, MIDI Editor, and Score Editor windows.

**Window Configuration List**

This command displays the Window Configuration List, which lets you recall and manage stored Window Configurations, as well as create new Window Configurations.

**New Configuration**

This command displays the New Configuration dialog, which lets you create a new Window Configuration.

**Update Active Configuration**

This command updates the selected Window Configuration with any changes to the layout and settings of windows depending on the Window Configuration’s properties.

**Auto-Update Active Configuration**

This command automatically updates the active Window Configuration as you make changes to the layout and settings of windows.

**Arrange**

The Arrange commands tile or cascade all open windows. Floating windows (such as plug-in, output, and send windows) and the Transport window are not affected by these commands.

**Tile**

Arranges all open windows in a tiled pattern on the screen.

**Tile Horizontal**

Arranges all open windows in a horizontally-tiled pattern on the screen. This option is not available if there are too many windows open.

**Tile Vertical**

Arranges all open windows in a vertically-tiled pattern, side by side, on the screen. This option is not available if there are too many windows open.

**Cascade**

Arranges all open windows in a cascading pattern on the screen.

**Hiding All Floating Windows**

The Hide All Floating Windows command hides or shows all floating windows. This command is useful for clearing the screen quickly so that you can work in the Edit or Mix windows.
**Close Window**

This command closes the front-most Pro Tools window.

---

**Mix**

This command displays the Mix window, used for recording and mixing tasks.

---

**Edit**

This command displays the Edit window, used for graphical editing and arranging of audio, MIDI and automation.

---

**MIDI Editor**

This command displays a MIDI Editor window, which is used to display and edit MIDI data for one or more MIDI or Instrument tracks. A check mark indicates that the MIDI Editor is the foremost window in the display. A diamond indicates that the MIDI Editor is not in front. You can have multiple MIDI Editor windows open.

---

**Score Editor**

This command displays a Score Editor window, which is used to view, edit, arrange, and print MIDI from your session as music notation. A check mark indicates that the Score Editor is foremost window in the display. A diamond indicates that the Score Editor is not in front. You can have multiple Score Editor windows open.

---

**MIDI Event List**

This command opens the MIDI Event List window. This floating window shows the contents of a MIDI track in a single list, so you can quickly insert, edit, or locate any type of MIDI data using your computer keyboard. A check mark indicates that the MIDI Event List is the foremost window in the display. A diamond indicates that the MIDI Event List is not in front.

---

**MIDI Editors**

These commands lets you choose which Midi Editor or Score Editor window is foremost on the screen.

**Bring to Front** This command brings the MIDI Editor or Score Editor window to the front.

**Send to Back** This command sends the MIDI Editor or Score Editor window to the back, behind the Edit window.

**Midi Editor Window List** This list shows any open MIDI Editor or Score Editor windows. Selecting a window from the list brings the window to the front.

---

**Task Manager**

This command displays the Task Window, used to monitor, pause, or cancel ongoing tasks.

---

**Workspace**

This command displays the Workspace browser, which can be used for searching, sorting, auditioning, and importing data. The Project, Volume, and Catalog browsers can be accessed from the Workspace browser.
**Project**

This command displays the Project Browser, used for Pro Tools file management with the current session.

*For more information on the Task window, Workspace, Project, and other browsers, see the DigiBase and DigiBase Pro Guide.*

**Browsers**

Use the Browsers command to select a currently open browser and bring it to the front. The Browsers submenu can also be used to bring all currently open browsers to the front, or send all browsers to the back. Choices include Bring to Front, and Send to Back.

**Transport**

This command opens the Transport window. This window can display counters, MIDI controls, and basic or expanded transport controls (configure the Transport window from View > Transport).

**Big Counter**

This command opens the Big Counter window. This window provides a large, easy to see reference for the current session time location. Time is displayed in the currently chosen Main Time Scale format.

**Automation**

This command opens the Automation window. This window lets you enable or suspend the writing of volume, pan, mute, plug-in, send level, send pan, and send mute automation for all tracks.

Before you can record automation, an automation type must be enabled. Buttons are highlighted when enabled. To suspend writing of automation, deselect the button for the automation type.
Memory Locations

This command opens the Memory Locations window. Here you can store up to 200 time location markers, selections, zoom settings, pre- and post-roll times, track show and hide states, track height states, and group enables. To recall a memory location, click the button for the location or, on your computer’s numeric keypad, type a period (.), then the number of the memory location, then type a period (.) again.

Machine Track Arming

(Pro Tools HD with MachineControl Option Only)

This command opens the Machine Track Arming window on systems that have the Machine-Control option installed. When using Machine-Control, this window lets you record-arm external recording devices from within Pro Tools.

Video Universe

(Pro Tools HD, and Pro Tools with Complete Production Toolkit Only)

This command opens the Video Universe window. The Video Universe lets you view, navigate, zoom, and select video clips on the main video track.

The Video Universe window displays the center video frame of each video clip in the main video track. Video frames are ordered sequentially according to their order in the Timeline, and the colored strip under each frame represents the color coding for that clip.

Video

This command opens the Video window, which displays QuickTime movies imported into the current session using the File > Import > Video command. This window also displays Avid Video when it is being scrubbed.

The window provides a sample-accurate, random-access reference for spotting sound effects, music, Foley, dialog, or other audio to the video.
Color Palette

This command opens the Color Palette window. Use this window to make color selections for tracks, clips, groups and markers.

Disk Space

This command opens the Disk Space window. This window shows the recording capacity of each hard drive attached to your system, measured in track minutes. This calculation is based on the bit depth and sample rate of the current session.

Undo History

This command opens the Undo History window. Use this window to view a list of undoable and redoable operations and return to any previous state. The Undo History can show editing times, enabling you to revert to the state a session held at a particular time.

System Usage

This command opens the System Usage window. This window provide meters that indicate how much of your system's processing power is being used in processing audio, and when writing and playing back automation.

All Pro Tools systems have three common system Activity meters. Pro Tools|HD and HD Native systems also provide a meter for monitoring PCI activity:

- PCI (Pro Tools|HD and HD Native Systems only)
- CPU (Native)
- CPU (Clip)
- Disk

Pro Tools |HD and Pro Tools with Complete Production Toolkit have two system cache meters:

- Disk Cache
- Timeline Cached
With Pro Tools|HD systems, there are three additional system usage meters:

- TDM Voices Allocated
- TDM Time Slots Used
- DSP Chip Usage (Accel Core, HD Core™, HD Accel, and HD Process™ cards)

With Pro Tools|HD systems, there is also the DSP Cache pop-up menu, which lets you choose Use DSP Cache (facilitating quicker session loading times) or Purge Cache (giving you a more accurate display of current DSP usage).
Eleven Rack

(Eleven Rack Only)

This command displays the Eleven Rack window, where you can control Eleven Rack entirely from your computer. It can be accessed when using Eleven Rack as an interface with Pro Tools, as well as when connected to a Pro Tools HD system for control over USB. The Eleven Rack window is only available when an Eleven Rack is connected to your Pro Tools system.
The Marketplace menu provides commands to access your Avid account and the online Avid Store (to shop for plug-ins, Avid support, or upgrades).

Your Account
This command lets you access and log in to your online Avid account.

Plug-Ins
This command lets you access the Avid Store to find plug-ins.

Avid Support
This command lets you access the Avid Store for support and training options.

Upgrades
This command lets you access the Avid Store for software options and upgrades.
Chapter 14: Help Menu

The Help menu commands provide links to Pro Tools Help, important Pro Tools documentation, and online resources.

Pro Tools Help
Select this command to access web-based Pro Tools Help within the Pro Tools web browser.

Pro Tools Help provides quick and easy access to workflows and reference information while Pro Tools is open. Built-in search capabilities and an index are included to better support your Help needs.

When you are connected to the Internet, Help provides access to the latest Pro Tools Help files as they become available (independently of major Pro Tools releases). If you are not connected to the Internet, Pro Tools will open the local English Help files that are installed with Pro Tools.

When you are connected to the Internet, you will also have access to translated versions of Pro Tools Help as they become available. If your localized language is not available, Pro Tools Help defaults to the English version.

Pro Tools Knowledge Base
Select this command to visit the Avid website for the online Avid Knowledge Base using the Pro Tools in-application web browser. The Avid Knowledge Base is your best resource for Pro Tools support and troubleshooting.

Avid Audio Forums
Select this command to access the online Avid Audio Forums using the Pro Tools in-application web browser.

Pro Tools Guides
Select the title of the document you want from the Pro Tools menu to open the document in Adobe Reader (available from www.adobe.com). Available documentation includes:

- Audio Plug-Ins Guide
- Pro Tools Menus Guide
- Pro Tools Reference Guide
- Pro Tools Shortcuts

Purchase Avid Support and Training
Select this command to access the online Avid Store for support and training options.
Check For Updates

Select this command to check for Pro Tools application and plug-in updates, either automatically or manually. An internet connection is required to be able to check for updates.

If updates are available for Pro Tools or any plug-ins, you are notified about what is available and how important the updates are for your system. You can then visit the Avid website to locate, download, and install the appropriate updates for your Pro Tools system.

About Pro Tools
(Windows Only)

Select this command to display the Pro Tools banner, which includes the version number of your Pro Tools software.
The Edit Window displays all audio clips, MIDI clips, video clips, and clip groups in a single, comprehensive Clip List.

The pop-up menu at the top of the Clip List provides general menu commands and tools for managing the contents of the list.

### Find
Use the Find command to display all clips in a list whose names contain a particular word or phrase. The Find command opens the Find Clips dialog, which lets you filter searches by name or to include only those clips added to the session since the previous search.

### Clear Find
This command returns the Clip List to displaying clips as they were displayed before the last Find.

### Select Parent in Project Browser
When this command is enabled, the DigiBase Project browser automatically highlights the parent file of any file or clip selected in the Clip List.

This setting is latching (meaning it maintains its setting).
Show Options

These options in the Clip List can show different types of clips and clip information. Select the Show options for the items you want to show. You can also deselect Show options to hide a type of clip or clip information to streamline the list of clip names.

Clip Types

Audio Shows Audio clips in the Clip List.
MIDI Shows MIDI clips in the Clip List.
Video Shows video clips in the Clip List.
Groups Shows clip groups in the Clip List.
Auto-Created Shows automatically-created clips. These are clips that were created as a by-product of cutting, pasting, and separating other clips. Since these by-product clips can become numerous, hiding them (by deselecting the option) helps you to avoid scrolling through an unnecessarily long Clip List.

Clip Information

Color Shows Track Color Coding as assigned with Default Clip Color Coding option in Display Preferences page, or as assigned in the Color Palette.
File Type Shows whether clips are audio, MIDI or video files.
Timebase Shows whether clips are tick-based or sample-based.
Processing State The icon indicates that a clip is an Elastic Audio clip.
File Name Shows the audio file from which the clip originated.
Disk Name Shows the name of the hard drive on which the clip resides.

Full Path Shows the full directory path name of the clip’s location.
Channel Name Shows channel names of each multichannel clip.
Scene and Take Shows the scene and take information of each multichannel clip.

Select Options

These options in the Clip List let you select specific clips so they can be dragged to tracks, processed with AudioSuite plug-ins, or exported.

All Selects all clips in the Clip List.
Unused Selects clips that have not been placed in a track in the current session. Offline clips appear in the Clip List as italicized and dimmed.
Unused Except Whole Files Selects clips that have not been placed in a track in the current session, but do not include whole-file clips. Whole-file clips are clips that were created when recording or importing audio, consolidating existing clips, and when nondestructively processing with an AudioSuite plug-in. Whole-file audio clips reference an entire audio file that resides on your hard drive. Whole-file audio clips are displayed in bold in the Clip List.
Offline Selects clips whose parent files cannot be located, or are not available, when opening a session or importing a track. Offline clips appear in the Clip List as italicized and dimmed; they appear in playlists as light blue clips with italicized names.
Sort By Options

The Sort By options provide methods for organizing large numbers of clips.

Audio clips can be sorted by:
- Clip Type
- Name
- Length
- Original Time Stamp
- User Time Stamp
- Timebase
- Start in Parent
- End in Parent
- File Name
- File Length
- File Creation Date
- File Modification Date
- Disk Name (audio and clip groups only)
- Track Format/Width
- By Channel Name
- By Scene and Take

MIDI clips can be sorted by:
- Name, Length
- Original Time Stamp
- User Time Stamp
- Timebase
- Start in Parent
- End in Parent.

Clips can also be sorted by Clip Type (Audio and MIDI), or in Ascending or Descending order.

Clear

This command lets you remove unwanted clips from the session. Whole-file clips can also be removed permanently from your hard drive.

⚠️ Clearing whole-file clips is destructive and cannot be undone. It permanently removes the file from your hard drive. There is no way to recover files deleted with this command.

Rename

This command lets you rename selected clips. When you rename a whole-file audio clip, you can specify whether to rename just the clip, or both the clip and the disk file.

Auto Rename

This command lets you specify the auto-naming options for a clip when new clips are created from it in the course of editing. You can also use it to rename a large number of clips at once in numerical order.

Auto-naming of clips does not affect the names of parent audio files. Instead, it stores pointers to the clips within the parent source file.

The Auto Rename command opens a dialog with the following fields:

- **Name** Determines the root name for the auto-created clips.
- **Number** Sets the start number for the sequentially numbered new clips.
- **Zeros** Determines the number of zeros that occur before the auto numbers.
- **Suffix** Specifies text to be appended to the end of the name, following the auto numbering.
**Time Stamp**

This command lets you select a clip (or clips) and redefine its SMPTE time stamp. The Original Time Stamp and the User-Time Stamp are then stored with your session.

When audio is first recorded, the User Time Stamp will match the Original Time Stamp, but you can change the User Time Stamp at any time using the Time Stamp command. This feature is particularly useful in post production situations where the SMPTE timecode on video “work prints” often changes from one edit revision to another.

**Replace Clip**

This command opens a dialog that lets you replace multiple instances of an audio clip in a playlist with another clip that you Command-drag (Mac) or Control-drag (Windows) from the Clip List.

The Replace Clip function only works on a selection that includes a single clip on one track. The function is not available when the playlist selection includes the start points for two or more clips. Also, if the selection is across several tracks, only the selection in the first (top) track is used.

---

**Compact**

The Compact command deletes unused portions of audio files to conserve disk space, and to prepare for cleaner hard drive back-ups. The Compact command also deletes audio if there are no clips referencing the data.

⚠️ *The Compact command is destructive and cannot be undone. It permanently alters the original audio files. There is no way to recover data deleted with this command.*

Because it permanently deletes audio data, the Compact command should be used only after you have completely finished your editing and are sure that you have no further use for the unused audio data.

The Compact Selected command can pad the clips of the compacted file by a user-selectable amount. You may want to do this because Pro Tools requires extra audio data before and after audio clips to create crossfades. So, if your clips have crossfades, or if you want to pad the clips for the sake of any future trimming, you should enter an appropriate amount of padding (in milliseconds) to allow for this.

---

**Export Clip Definitions**

This command lets you export clip definitions for audio files within each session, so that you can use an audio file’s clips in another session, or with another application that supports them.

The Export Clip Definitions command does not export clips as audio files (unlike the Export Clips as Files command). Instead, it stores pointers to the clips within the parent source file.
Export Clips as Files

This command lets you export clips as audio files. Use this command if you intend to use a clip in other sessions (or other audio applications) without using its parent source file.

This command also provides a way to convert clips to a different audio format, sample rate, or bit depth.

Export Clip Groups

This command lets you export clip groups as files. Use this command if you intend to use a clip group in other sessions.

If you are exporting clip groups to another hard drive, you may want to copy any referenced audio files as well. This way you can move clip groups not only from one session to another, but from one system to another.

Recalculate Waveform Overviews

This command re-creates the session’s waveform overview data (the data used to create waveform displays). Use this command if you think overview data for a session has become corrupted, or if you import audio files which have no overview data into a session.

Recalculating waveform overviews may take some time if there are many tracks in the session.

Timeline Drop Order

This command sets whether tracks dragged from the Clip List are dropped sequentially in a single track or spread across multiple tracks.

Top to Bottom When enabled, clips are spread across multiple destination (drop) tracks, or on new tracks (when dragging to the area below the last track or to the Track List).

Left to Right When enabled, clips are placed sequentially in a single destination (drop) track or a newly created track (when dragging to the area below the last track or to the Track List).
Index

A
AAF 12
About Pro Tools command 3, 74
Add Key Change command 44
Advanced Authoring Format 12
AFL (After Fader Listen) mode 53
After Fader Listen mode 53
All MIDI Notes Off command 45
Assignment View option 27
Audio MIDI Setup 60
AudioSuite menu 47
Auto Rename Clip List command 77
Automation
  Composite Playlist 26
  Trim Playlist 26
Automation commands 20
  Copy To Send 20
  Glide to All Enabled 21
  Glide to Current 21
  Trim to All Enabled 21
  Trim to Current 21
  Write to All Enabled 21
  Write to Current 21
Automation Follows Edit option 52
Automation view options 26
  Composite Playlist 26
  Trim Playlist 26
Automation Window command 65
Auto-Spot Clips option 53

B
Bars:Beats Time Scale 27
Beat Detective command 45
Big Counter command 65
Bounce options
  Bit Depth 9
  Conversion Quality 10
  Convert After Bounce 10
  Convert During Bounce 10
  Enforce Avid Compatibility 9
  File Type 9
  Format 9
  Import After Bounce 9, 10
  Sample Rate 9
  Source 9
  Use Squeezer 10
Bounce to Disk command 8
Bounce to QuickTime Movie command 10
Bring Clip to Front command 33
Browsers Window commands 65

C
Calibration Mode 54
Capture Clip command 34
Center Playhead Scrolling option 51
Change Duration command 41
Change Edit to Match Timeline Selection command 17
Change Meter command 38
Change Timeline to Match Edit Selection command 17
Change Velocity command 41
Clear All Clip Indicators 32
Clear Clip List command 77
Clear command 15
Clear Find command 75
Clear Special commands 16
  All Automation 16
  Pan Automation 16
  Plug-In Automation 16
Clear Trim Automation command 32
Click Setup command 62
Click/Countoff Options command 52
Clip List
  show/hide 24
Clip List menu 75
  Auto Rename command 77
  Clear command 77
  Clear Find command 75
  Compact command 78
Export Clip Definitions command 78
Export Clip Groups command 79
Export Clips as Files command 79
Find command 75
Recalculate Waveform Overviews command 79
Rename command 77
Replace Clip command 78
Select options 76
Select Parent in Project Browser command 75
Show options 76
Sort By options 77
Time Stamp command 78
Timeline Drop Order command 79
Clip menu 33
Bring to Front command 33
Capture command 34
Clip view options 25
Conform to Tempo command 36
Elastic Properties command 35
Group command 34
Identify Sync Point command 35
Lock command 33
Loop command 34
Mute/Unmute command 19
Quantize to Grid command 35
Rating 33
Regroup command 34
Remove Pitch Shift command 36
Remove Sync Point command 35
Remove Warp command 36
Rename command 34
Send to Back command 33
Ungroup All command 34
Ungroup command 34
Unlock command 33
Unloop command 34
Clip view options
Channel Name 25
Clip Gain Info 25
Clip Gain Line 25
Current Time 25
Display on All Channels 25
Name 25
No Time 25
Original Time Stamp 25
Overlap 25
Processing State 25
Rating 25
Scene and Take 25
Sync Point 25
User Time Stamp 25
clips
locking 33
unlocking 33
Close Session command 5
Coalesce Trim Automation command 32
Coalesce VCA Master Automation command 32
Color Palette Window command 67
Compact command 78
Conductor rulers 24
Configurations menu
Window Configuration List 63
Conform to Tempo 36
Consolidate command 18
Constant Tempo command 39
Continuous Scrolling option 51
Conversion Quality option 10
Convert After Bounce option 10
Convert During Bounce option 10
Copy command 15
Copy Selection To commands 19
Copy Special commands 16
All Automation 16
Pan Automation 16
Plug-In Automation 16
Copy To Send command 20
Counters Transport view option 27
Create Click Track command 32
Create Fades command 22
Current Feet+Frame Position command 59
Current Timecode Position command 59
Cut command 15
Cut Special commands 16
All Automation 16
Pan Automation 16
Plug-In Automation 16
Cut Time command 38

D
Delay Compensation option 54
Delete Fades command 22
Delete Tracks command 30
destructive editing
compacting audio files 78
Destructive Record mode 49
DigiDelivery 8
Disk Allocation dialog 56
Disk Space Window command 67
Display menu
  Narrow Mix window option 23
DSP usage 68
Duplicate command 17
Duplicate Track command 30
Dynamic Transport Mode 51

E
Edit menu 15
  Automation commands 20
  Clear command 15
  Clear Special commands 16
  Consolidate command 18
  Copy command 15
  Copy Selection To commands 19
  Copy Special commands 16
  Cut command 15
  Cut Special commands 16
  Duplicate command 17
  Fades commands 22
  Heal Separation command 18
  Insert Silence command 17
  Paste command 15
  Paste Special commands 16
  Redo command 15
  Repeat command 17
  Select All command 17
  Selection commands 17
  Separate Clip commands 18
  Shift command 17
  Snap To commands 17
  Strip Silence command 19
  TCE Edit to Timeline Selection command 19
  Thin All Automation command 20
  Thin Automation command 20
  Trim Clip commands 18
  Undo command 15

Edit window
  Universe view 24

Edit Window command 64
Edit Window view options 23
Edit/Tool Mode Keyboard Lock option 53
Elastic Properties command 35
End to Insertion 18
Ethernet Controllers page 57

Event menu
  Add Key Change command 44
  All MIDI Notes Off command 45
  Beat Detective command 45
  Event Operations commands 40
  Identify Beat command 45
  MIDI Real-Time Properties command 44
  MIDI Track Offsets command 44
  Remove Duplicate Notes command 44
  Renumber Bars command 45
  Tempo Operations commands 39
  Event Operations commands 40
    Change Duration 41
    Change Velocity 41
    Flatten Performance 43
    Input Quantize 42
    Insert Time 43
    Quantize 40
    Restore Performance 43
    Transpose 41

Exit command 14
Expanded Transport view option 27
Export Clip Definitions command 78
Export Clip Groups command 79
Export Clips as Files command 79
Export commands 12
Export MIDI command 12
Export Selected Tracks as New Session command 12
Export Selected Tracks as OMF/AAF command 12
Export Selected Tracks to Sequence command 12
Export Session Info as Text command 12
External Timecode Offsets command 60

F
Fade To End command 22
Fade to Start command 22
Fades commands 22
  Create 22
  Delete 22
  Fade to Start 22
Feet.Frames Time Scale 27

File menu 5
  Bounce to commands 8
  Close Session command 5
  Exit command 14
  Export commands 12
  Export MIDI command 12
  Export Selected Tracks as New Session command 12
  Export Selected Tracks as OMF/AAF command 12
  Export Selected Tracks to Sequence command 12
  Export Session Info as Text command 12
Get Info command 13
Import Audio command 11
Import Clip Groups command 11
Import MIDI command 11
Import Sequence from Avid Interplay command 11
Import Session Data command 10
Import VENUE Channel Names as Track Names command 12
Import Video command 11
New Session command 5
Open Recent command 5
Open Session command 5
Revert to Saved command 8
Save As command 5
Save As Template command 7
Save command 5
Save Copy In command 6
Score Setup command 13, 14
Send to Sibelius command 8
Send via DigiDelivery command 8
Find Clip List command 75
Flatten Performance command 43

G
Get Info command 13
Glide to All Enabled command 21
Glide to Current command 21
Group Clip command 34
Group Track command 29

H
Hardware Setup dialog 55
Heal Separation command 18
Help menu
  Pro Tools documentation 73
Hide All Floating Windows command 63
Hide Others command 3
Hide Pro Tools command 3

I
I/O Setup dialog 58
Identify Beat command 45
Identify Sync Point command 35
Import Audio command 11
Import Clip Groups command 11
Import commands 10
Import MIDI command 11
Import Sequence from Avid Interplay command 11
Import Session Data command 10
Import VENUE Channel Names as Track Names command 12
Import Video command 11
Input Devices command 61
Input Filter command 61
Input Quantize command 42
Insert Silence command 17
Insert Time command 38
Items To Copy
  Preserve Folder Hierarchy 7

K
Knowledge Base 73

L
Latch solo option 53
Linear Tempo command 39
Link Timeline and Edit Selection option 52
Link Track and Edit Selection option 52
Lock Clip command 33
Loop Clip command 34
Loop Playback option 51
Loop Record mode 49
Low Latency Monitoring 54

M
Machine Control page 56
Machine Track Arm Window command 66
Machine Track Arming Profiles dialog 58
Main Counter 27
Main Counter view options
  Bars:Beats Time Scale 27
  Feet:Frames Time Scale 27
  Minutes:Seconds Time Scale 27
  Samples Time Scale 27
  Timecode Time Scale 27
Make Active Track command 30
Make Inactive Track command 30
Memory Locations Window command 66
Mic Preamps page 57
MIDI Beat Clock command 60
MIDI Controllers page 57
MIDI Controls Transport view option 27
MIDI Real-Time Properties command 44
MIDI Setup commands
  Input Devices 61
  Input Filter 61
  MIDI Beat Clock 60
MIDI Studio command 60
MIDI Thru command 52
MIDI Track Offsets command 44
Minutes:Seconds Time Scale 27
Mirror MIDI Editing option 52
Mix Window command 64
Mix Window view options 23
Momentary Latch option 53
Move Song Start command 38
Mute Frees Assigned Voice option 52
Mute/Unmute Clip command 19

N
Narrow Mix window option 23
New Session command 5
New Track command 29
No scrolling option 51
Nondestructive Record mode 49

O
OMFI 12
Open Media Framework Interchange (OMFI) 12
Open Recent command 5
Open Session command 5
Options menu
Automation Follows Edit option 52
Auto-Spot Clips option 53
Calibration Mode 54
Click/Countoff command 52
Delay Compensation option 54
Destructive Record mode 49
Dynamic Transport Mode 51
Edit/Tool Mode Keyboard Lock 53
Link Timeline and Edit Selection option 52
Link Track and Edit Selection option 52
Loop Playback option 51
Loop Record mode 49
Low Latency Monitoring 54
MIDI Thru command 52
Mirror MIDI Editing option 52
Mute Frees Assigned Voice option 52
Pre/Post Roll option 50
Pre-Fader Metering option 53
Preferences command 3
Preferences dialog 62
Preserve Folder Hierarchy command 7
Print Score 14
Pro Tools documentation 73
Pro Tools Help 73
Pro Tools Knowledge Base 73
Pro Tools menu 3
About Pro Tools command 3, 74
Hide Others command 3
Hide Pro Tools command 3
Preferences command 3
Quit Pro Tools command 3
Services command 3
Show All command 3
Project browser 65
Project Window command 65

P
Page Scrolling option 51
Parabolic Tempo command 39
Paste command 15
Paste Special commands
Merge 16
Repeat to Fill Selection 16
To Current Automation Type 16
Peripherals dialog 56
Ethernet Controllers page 57
Machine Control page 56
Mic Preamps page 57
MIDI Controllers page 57
Satellite page 57, 58
Synchronization page 56
PFL (Pre Fader Listen) mode 53
Play Edit Selection command 17
Play Timeline Selection command 17
Playback Engine dialog 55
Playhead 51
Pre Fader Listen mode 53
Pre/Post Roll option 50
Pre-Fader Metering option 53
Preferences command 3
Preferences dialog 62
Preserve Folder Hierarchy command 7
Print Score 14
Pro Tools documentation 73
Pro Tools Help 73
Pro Tools Knowledge Base 73
Pro Tools menu 3
About Pro Tools command 3, 74
Hide Others command 3
Hide Pro Tools command 3
Preferences command 3
Quit Pro Tools command 3
Services command 3
Show All command 3
Project browser 65
Project Window command 65

Index 85
Q
Quantize command 40
Quantize to Grid command 35
QuickPunch mode 49
Quit Pro Tools command 3

R
Rating clips 33
Recalculate Waveform Overviews command 79
Redo command 15
Regroup Clip command 34
Remove Duplicate Notes command 44
Remove Pitch Shift command 36
Remove Sync Point command 35
Remove Warp command 36
Rename Clip command 34
Rename Clip List command 77
Renumber Bars command 45
Repeat command 17
Replace Clip command 78
Restore Last Selection command 15
Restore Performance command 43
Revert to Saved command 8
rulers
Conductor rulers 24
Timebase rulers 24
Rulers view options 24, 25

S
Samples Time Scale 27
Satellite page 57, 58
Save As command 5
Save as Template command 7
Save command 5
Save Copy In command 6
Items To Copy 6
Scale Tempo command 39
Score Setup 13
Scroll to Track command 31
Scrolling options 51
After Playback 51
Center Playhead 51
Continuous 51
None 51
Page 51
Scrub in Video Window command 50
S-Curve Tempo command 39
Select All command 17
Select Clip List options 76

Select Parent in Project Browser command 75
Selection commands 17
  Change Edit to Match Timeline 17
  Change Timeline to Match Edit 17
  Play Edit 17
  Play Timeline 17
Send Clip to Back command 33
Send To Sibelius command 8
Send via DigiDelivery command 8
Sends A-E view options 27
Sends F–J view options 27
Separate Clip commands 18
  At Selection 18
  At Transients 18
  On Grid 18
Services command 3
Session Setup window 59
Set Record Tracks to Auto Input command 31
Set Record Tracks to Input Only command 31
Setup menu 55
  Click command 62
  Current Feet+Frame Position command 59
  Current Timecode Position command 59
  Disk Allocation dialog 56
  External Timecode Offsets command 60
  Hardware Setup dialog 55
  I/O dialog 58
  Machine Track Arming Profiles dialog 58
  MIDI commands 60
  Peripherals dialog 56
  Playback Engine dialog 55
  Preferences dialog 62
  Session Setup window 59
  Video Sync Offset command 58
Shift command 17
Show All command 3
Show Clip List options 76
SIP (Solo In Place) mode 53
Snap To commands 17
  Next 17
  Previous 17
Solo In Place mode 53
Solo Latch options
  Latch 53
  Momentary 53
  X-OR (Cancels Previous Solo) 53
Solo Mode options
  AFL (After Fader Listen) 53
  PFL (Pre Fader Listen) 53
  SIP (Solo In Place) 53
Solo modes and options 53
Sort By options 77
Split into Mono Track command 30
Step Input command 43
Stretch Tempo command 39
Strip Silence command 19
Synchronization page 56
System Usage Window command 67

T
- Task Manager Window command 64
- TCE Edit to Timeline Selection command 19
- TDM Time Slot usage 68
- TDM Voices Allocated 68
- Tempo Operation commands
  - Constant command 39
- Tempo Operations commands 39
  - Linear 39
  - Parabolic 39
  - Scale 39
  - S-Curve 39
  - Stretch 39
  - Tempo Operations Window 39
- Tempo Operations Window command 39
- Thin All Automation command 20
- Thin Automation command 20
- Time Compression/Expansion plug-in 19
- Time Operations commands
  - Change Meter 38
  - Cut Time 38
  - Insert Time 38
  - Move Song Start 38
  - Time Operations Window 37
- Time Operations Window command 37
- Time Stamp Clip List command 78
- Timebase rulers 24
- Timecode Time Scale 27
- Timeline Drop Order command 79
- Track 29
- Track List
  - show/hide 24
- Track menu
  - Clear All Clip Indicators command 32
  - Clear Trim Automation 32
  - Coalesce Trim Automation 32
  - Coalesce VCA Master Automation 32
  - Create Click Track 32
  - Delete command 30
  - Duplicate command 30
  - Group command 29
  - Make Active command 30
  - Make Inactive command 30
  - New Track command 29
  - Scroll to Track command 31
  - Set Record Tracks to Auto Input command 31
  - Set Record Tracks to Input Only command 31
  - Split into Mono command 30
  - Write MIDI Real-Time Properties command 30
- Track Number command 27
- TrackPunch mode 49
- Transport Online command 50
- Transport view options 27
- Transport Window command 65
- Transpose command 41
- Trim Clip commands 18
  - End to Fill Selection 18
  - Start to Fill Selection 18
  - Start to Insertion 18
  - To Fill Selection 18
  - To Selection 18
- Trim to All Enabled Automation command 21
- Trim to Current Automation command 21

U
- Undo command 15
- Undo History Window command 67
- Ungroup All Clip command 34
- Ungroup Clip command 34
- Universe
  - show/hide 24
- Universe window 24
- Universe Window command 66
- Unlock Clip command 33
- Unloop Clip command 34
- Use Squeezer option 10

V
- Video Out FireWire command 50
- Video Sync Offset command 58
- Video Track Online command 50
- Video Window command 66
- View menu 23
  - Automation view options 26
  - Edit Window view options 23
  - Main Counter view options 27
  - Mix Window view options 23
  - Rulers view options 24
  - Sends A-E view options 27
  - Sends F–J view options 27

Index  87
Track Number command 27
Transport view options 27
Waveform view options 26

W
Waveform view options
  Outline views 26
  Peak view 26
  Power view 26
  Rectified view 26
Window Configuration List 63
Window menu 63
  Automation command 65
  Big Counter command 65
  Browsers commands 65
  Color Palette command 67
  Disk Space command 67
  Edit command 64
  Machine Track Arm command 66
  Memory Locations command 66
  Mix command 64
  Project command 65
  System Usage command 67
  Task Manager command 64
  Transport command 65
  Undo History command 67
  Universe command 66
  Video command 66
  Workspace command 64
Windows menu
  Hide All Floating Windows command 63
Workspace browser 64
Workspace Window command 64
Write MIDI Real-Time Properties command 30
Write to All Enabled Automation command 21
Write to Current Automation command 21

X
X-OR (Cancels Previous Solo) Latch option 53